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1 Image Consulting

1.1 Basic Concepts
Images are classified as public, private, and shared.

Image Type Description

Public image A public image is a standard, widely used image. It contains an
OS and preinstalled public applications and is available to all
users. Public images are very stable and their OS and any
included software have been officially authorized for use. If a
public image does not contain the environments or software you
need, you can use a public image to create an ECS and then
deploy the required environments or software on it.
Public images include the following OSs to choose from: Ubuntu
and CentOS
For more information about public images, see Managing
Public Images.
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Image Type Description

Private
image

A private image contains an OS or service data, preinstalled
public applications, and a user's personal applications. Private
images are only available to the users who created them.
A private image can be a system disk image, data disk image,
ISO image, or full-ECS image.
● A system disk image contains an OS and preinstalled

software for various services. You can use a system disk
image to create ECSs and migrate your services to the cloud.

● A data disk image contains only service data. You can use a
data disk image to create EVS disks and use them to migrate
your service data to the cloud.

● An ISO image is created from an external ISO image file. It is
a special image that is not available on the ECS console.

● A full-ECS image contains an OS, preinstalled software, and
service data. A full-ECS image is created using differential
backups and the creation takes less time than creating a
system or data disk image of the same size.

Shared
image

A shared image is a private image another user has shared with
you.
For more information about shared images, see Sharing
Images.

 

You can modify an image, share images, export images, encrypt images, replicate
images, export an image list, and delete images.

Table 1-1 Managing private images

Feature Description Helpful Link

Modifying an
image

To facilitate private image
management, you can modify the
following attributes of an image:
name, description, minimum
memory, maximum memory, and
advanced functions such as NIC
multi-queue and SR-IOV driver.

Modifying an Image

Sharing images You can share an image with other
HUAWEI CLOUD accounts. These
accounts can use your shared private
image to quickly create ECSs or EVS
disks.

● Sharing Images
● Image Sharing

FAQs

Exporting
images

You can export private images to
your OBS bucket and download them
to your local PC for backup.

Exporting an Image
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Feature Description Helpful Link

Encrypting
images

You can create encrypted images to
improve data security. The encryption
mode is KMS envelope encryption.
Encrypted images can be created
from external image files or
encrypted ECSs.

● Encryption
Method

● Creating
Encrypted Images

Replicating
images within
a region

By replicating images within a
region, you can convert encrypted
and unencrypted images into each
other or enable some advanced
features, for example, quick instance
provisioning.

Replicating Images
Within a Region

Tagging an
image

You can tag your private images for
easy management and search.

Tagging an Image

Exporting
image list

You can export the public or private
image list in a given region in CSV
format, facilitating local maintenance
and query.

Exporting Image List

Deleting
images

You can delete images that will be
no longer used. Deleting an image
does not affect the ECSs created
from that image.

Deleting Images

 

1.2 How Do I Select an Image?
When creating an ECS or BMS, you can select an image based on the following
factors:

● Image Type
● Image Fee
● OS

Image Type
Images are classified into public, private, and shared images.
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Table 1-2 Image types

Imag
e
Type

Description Availability/
Security

Billing

Publi
c
imag
e

A public image is a standard, widely
used image. It contains an OS and
preinstalled public applications and is
available to all users. Public images are
very stable and their OS and any
included software have been officially
authorized for use.

High Free

Privat
e
imag
e

A private image contains an OS or
service data, preinstalled public
applications, and a user's personal
applications. Private images are only
available to the users who created
them.

Medium Free

Share
d
imag
e

A shared image is a private image
another user has shared with you.

Low Free

 

You can select an image as follows:

● If you only need an OS, select a public image.
● If you want to clone an existing ECS, select a private image.
● If you want to use an image shared by others, select a shared image.

Image Fee
You may be billed for using an image. For details, see What Are the Billing
Standards of IMS?

OS
When selecting an OS, consider the following factors:

● Architecture types

Image Management Service
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System
Architecture

Applicable
Memory

Constraints

32-bit Smaller than 4
GB

● If the instance memory is greater
than 4 GB, a 32-bit OS cannot be
used.

● A 32-bit OS only allows addressing
within a 4 GB memory range. An OS
with more than 4 GB memory
cannot be accessed.

64-bit 4 GB or larger If your application requires more than 4
GB of memory or the memory may
need to be expanded to more than 4
GB, use a 64-bit OS.

 
● OS types

OS Type Applicable Scenario Constraints

Linux ● High-performance server
applications (for example,
Web) and working with
common programming
languages such as PHP and
Python.

● Databases such as MySQL.
(You need to install the
database.)

The system disk must
be at least 40 GB, and
there must be at least
512 MB of memory.

 

1.3 What Do I Do If I Want to Set Up an OpenVPN or
PyTorch Environment But No Public Images Containing
OpenVPN or PyTorch Are Available?

A public image does not contain applications such as OpenVPN and PyTorch. You
need to manually set up the environment or install the applications from an
image on the Marketplace.

1.4 How Do I Increase the Image Quota?

What Is Quota?

Quotas can limit the number or amount of resources available to users, such as
the maximum number of ECSs or EVS disks that can be created.

If the existing resource quota cannot meet your service requirements, you can
apply for a higher quota.

Image Management Service
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How Do I View My Quotas?
1. Log in to the management console.

2. Click  in the upper left corner and select the desired region and project.
3. In the upper right corner of the page, choose Resources > My Quotas.

The Service Quota page is displayed.
4. View the used and total quota of each type of resources on the displayed

page.
If a quota cannot meet service requirements, apply for a higher quota.

How Do I Apply for a Higher Quota?
1. Log in to the management console.
2. In the upper right corner of the page, choose Resources > My Quotas.

The Service Quota page is displayed.
3. Click Increase Quota in the upper right corner of the page.
4. On the Create Service Ticket page, configure parameters as required.

In the Problem Description area, fill in the content and reason for
adjustment.

5. After all necessary parameters are configured, select I have read and agree
to the Ticket Service Protocol and Privacy Statement and click Submit.

1.5 What Are the Differences Between Images and
Backups?

CBR and Image Management Service (IMS) have some complementary functions
and can be used together in certain scenarios. Like CBR, IMS can also be used to
back up ECSs.

Differences Between Backups and Images
Table 1-3 lists the differences between them.

Image Management Service
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Table 1-3 Differences between backups and images

Item CBR IMS

Concept A backup contains the status,
configuration, and data of a
cloud server or disk stored at
a specific time point for
recovery in case of a fault. It is
used to ensure data security
and improve availability.

An image provides all
information required for starting
a cloud server. It is used to
create a cloud server and deploy
software environments in
batches. A system disk image
contains an OS and pre-installed
application software for running
services. A data disk image
contains service data. A full-ECS
image contains data of the
system disk and data disks.

Usage
method

● Data storage location:
Unlike server or disk data,
backups are stored in OBS.
Deleting a disk will not
clear its backups.

● Operation object: A server
or disk can be backed up at
a given point in time. CBR
supports automatic backup
and automatic deletion by
configuring backup policies.

● Usage: Backups can be
used to restore data to the
original server or disk, or to
create a new disk or full-
ECS image.

● Support exporting to a
local PC: No

● Data storage location: Unlike
server or disk data, backups
are stored in OBS. If a server
or disk that is created using
an image is deleted, the
image will not be cleared.

● Operation object: The system
disk and data disks of a
server can be used to create
private images. You can also
create private images using
external image files.

● Usage: System disk images or
full-ECS images can be used
to create new servers, and
data disk images can be used
to create new disks for service
migration.

● Support exporting to a local
PC: Yes However, full-ECS
images cannot be exported to
a local PC.

Application
scenarios

CBR applies to the following
scenarios:
● Data backup and

restoration
● Rapid service deployment

and migration

IMS applies to the following
scenarios:
● Server migration to the cloud

or between clouds
● Deploying a specific software

environment
● Deploying software

environments in batches
● Backing up server operating

environments

Image Management Service
FAQs 1 Image Consulting

Issue 02 (2023-08-10) Copyright © Huawei Technologies Co., Ltd. 7



Item CBR IMS

Advantages Supports automatic backup.
Data on a server or disk at a
certain time point can be
retained periodically or
quantitatively. You can back
up on-premises VMware VMs,
synchronize the backups to
the cloud, and then use the
backups to restore data to
new ECSs.

Supports system disk backup.
You can import the data disk
image of a local server or a
server provided by another cloud
platform to IMS and then use
the image to create an EVS disk.

 

NO TE

Although backups and images are stored in OBS, you cannot view backup and image data
in OBS, because they do not occupy your resources. Backup fees are charged according to
the CBR billing standards, and image storage fees are charged according to the OBS billing
standards.

Relationship Between Backups and Images
1. You can use an ECS backup to create a full-ECS image.

2. Before creating a full-ECS image for an ECS, you need to back up the target
ECS.

3. A backup is compressed when it is used to create an image, so the size of the
generated image may be smaller than the backup size.

1.6 Can I Tailor an Image?
When you import an external image file, you are advised to import the image that
contains the official OS release version. Do not tailor or highly customize the
release version. Otherwise, problems may occur.

OS vendors do not always update OS release versions regularly. Some versions are
no longer maintained, and these deprecated versions no longer receive security
patches. Ensure that you read the update notifications from OS vendors and
update your OS so that it runs properly.

1.7 How Can I Back Up the Current Status of an ECS for
Restoration in the Case of a System Fault?

You can back up the ECS in any of the following ways:

● (Recommended) Use CBR to create a scheduled backup task for the ECS. If
the ECS fails, select a backup corresponding to the time you want the ECS to
restore to, create a full-ECS image from the backup, and use the image to
apply for a new ECS or to reinstall the OS.

Image Management Service
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● Create a system disk image from the ECS. If the ECS fails, use the system disk
image to apply for a new ECS or to reinstall the OS.

● Create a snapshot for the system disk of the ECS. If the ECS fails, you can roll
it back from the snapshot.

1.8 How Can I Apply a Private Image to an Existing
ECS?

● You can change the OS of the ECS later. When you change the OS, select the
created private image. For details about how to change the OS, see Changing
the OS.

1.9 Can I Import Data from a Data Disk Image to a
Data Disk?

No.

A data disk image can only be used to apply for a new disk and its data cannot be
imported to a disk. To import the data, perform the following operations:

1. Use the data disk image to create a temporary disk.
2. Attach the temporary disk to the ECS where the target disk is located.
3. Copy data from the temporary disk to the target disk. Then, delete the

temporary disk.

1.10 Can I Use Private Images of Other Tenants?
Yes.

Other tenants can share a private image with you. You can use it after accepting
it. For details about image sharing, see Sharing Specified Images.
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2 Image Creation

2.1 Image Creation FAQs

How Can I Use an ECS to Quickly Provision Identical ECSs?

If you have an ECS with applications deployed, you can use the ECS to create a
private image and then use the image to create identical ECSs. In this way, you do
not need to deploy applications repeatedly.

● Creating a System Disk Image from a Linux ECS
● Creating an ECS from an Image

How Many Private Images Can I Create Under an Account?

At present, you can create up to 50 private images under a given account within a
region. If you need to create more than 50 private images, submit a service ticket
to increase your quota. For details, see How Do I Increase the Image Quota?

Do I Have to Stop the ECS Before Using It to Create a Private Image?

No. You can create an image from a running ECS. However, if data is written to
the ECS during image creation, that new data will not be included in the created
image.

Where Can I View the Image Creation Progress? How Long Does It Take to
Create an Image?

Log in to the management console. Choose Compute > Image Management
Service and click the Private Images tab. Monitor the image creation progress in
the Status column.

The image creation involves the installation of Xen and KVM drivers, OS kernel
loading, and GRUB boot configuration, which may take a long time. In addition,
the network speed, image file type, and disk size have an impact on how long
image creation takes.
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Can I Select a Private Image Created Under a Subaccount When Creating an
ECS Under the Main Account?

Yes.

Private images created under a subaccount are visible to the main account and all
the other subaccounts (if any) under the main account.

● If the private image is a system disk image or full-ECS image, you can select
Private Image for Image when creating an ECS. Then, select this image from
the drop-down list.

● If the private image is a data disk image, select Create from image for Select
Data Source when creating an EVS disk. Then, select this image in the
displayed dialog box.

In addition, private images created under the main account are visible to all of its
subaccounts.

2.2 Full-ECS Image FAQs

What Is a Full-ECS Image?
A full-ECS image contains the OS, applications, and service data of an ECS.
Generally, a full-ECS image is used to migrate all data of an ECS. For example:

● Sharing an ECS with other tenants
● Migrating an ECS from a region to another (for example, from CN East-

Shanghai1 to CN South-Guangzhou)
● Migrating data from an old ECS to a new one

Why Do I Have to Select a Vault When Creating a Full-ECS Image? Do I
Need to Pay for the Vault?

When creating a full-ECS image from a CBR backup, you must select a vault. The
vault is where your images and backups are stored. You need to pay for the vault.

When creating a full-ECS image from a CSBS backup, the vaults storing CSBS
backups are not open to users but still need to be billed.

Therefore, no matter which backup type you select, you need to pay for the vault.
Selecting a vault does not mean that you need to pay extra fees.

Where Can I View the Data Disk Information of a Successfully Created Full-
ECS Image?

After a full-ECS image is created, only the system disk information (Disk
Capacity) is displayed in the image list and image details. You can view the data
disk information on the CSBS or CBR console, depending on where the full-ECS
image is created from.

The following describes how to view the data disk details in CBR:

1. In the private image list, click the full-ECS image name.

Image Management Service
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Image details are displayed.
2. Locate Source and click the backup ID following it.

The CBR details page is displayed.

Figure 2-1 Image details

3. Click the Disk Backup tab. Details about the system disk and data disks are
displayed.

Figure 2-2 Disk backup

What Are the Restrictions on Using a Full-ECS Image?
● A full-ECS image cannot be exported. You are advised to create images for the

system disk and data disks separately and then export the images.
● A full-ECS image is shareable only when it is created from a CBR backup or

from an ECS that has never had a CSBS backup.
● A full-ECS image cannot be replicated within the same region.

2.3 How Can I Use a Backup to Create an EVS Disk or
ECS?

You can use CSBS backups to create ECSs and use VBS backups to create EVS
disks.

● CSBS backups cannot be directly used to create ECSs. You need to use a
backup to create a private image and then use the private image to create
ECSs.
For details about how to create a private image from a CSBS backup, see
Creating a Full-ECS Image from a CSBS Backup. For details about how to
create ECSs from a private image, see Creating an ECS from an Image.

● VBS backups can be directly used to create EVS disks. For details, see Using a
Backup to Create a Disk.
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2.4 Is There Any Difference Between the Image Created
from a CSBS/CBR Backup and That Created from an
ECS?

No.

You can create a full-ECS image from an ECS, a CSBS backup, or a CBR backup.

When you create a full-ECS image from an ECS, the system first creates a backup
for the ECS and then uses the backup to create an image. Therefore, the image is
essentially created from an ECS backup no matter you use an ECS or a CSBS/CBR
backup.

2.5 Why Can't I Find an ISO Image When I Want to Use
It to Create an ECS or Change the OS of an ECS?

● An ISO image created from an ISO file is used only for creating a temporary
ECS. It will not be available on the ECS console. You cannot use it to create
ECSs or change ECS OSs. You need to install an OS on the temporary ECS and
use that ECS to create a system disk image which can be used to create ECSs
or change ECS OSs.

● You are not advised to use a temporary ECS as a normal ECS because it has
limited functionality. For example, disks cannot be attached to it.

For details about how to create a private image using an ISO file, see:

● Creating a Linux System Disk Image from an ISO File

2.6 How Do I Create a Full-ECS Image Using an ECS
That Has a Spanned Volume?

An ECS used to create a Windows full-ECS image cannot have a spanned volume.
If you attempt to create an image from an ECS with a spanned volume, when the
image is used to create new ECSs, data may be lost.

If an ECS has a spanned volume, back up data in the spanned volume and then
delete this volume from the ECS. Use the ECS to create a full-ECS image. Use the
full-ECS image to create an ECS. Then, use the backup to create a spanned volume
for the new ECS if necessary.

NO TE

If a Linux ECS has a volume group or a logical volume consisting of multiple physical
volumes, to ensure you do not lose any data, back up data in the volume group or logical
volume and delete the volume group or logical volume before using this ECS to create a
full-ECS image.
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2.7 Why Is Sysprep Required for Creating a Private
Image from a Windows ECS?

Why Is Sysprep Required?
For a user that needs to be added to a domain and uses the domain account to
log in to Windows, Sysprep is required before a private image is created.
Otherwise, the image will contain information about the original ECS, especially
the SID. ECSs with the same SID cannot be added to a domain. If Windows does
not require any user or ECS to be added to a domain, you do not need to run
Sysprep.

CA UTION

● Before running Sysprep, ensure that Windows is activated.
● For details about Sysprep, visit https://docs.microsoft.com/en-us/previous-

versions/windows/it-pro/windows-vista/cc721940(v=ws.10)?
redirectedfrom=MSDN.

Restrictions on Running Sysprep
Sysprep can only be used for configuring a new Windows installation. You can run
Sysprep multiple times to install and configure Windows. However, you can reset
and activate a Windows OS only three times, and you are not allowed to use
Sysprep to re-configure an existing Windows OS.

NO TE

In the Windows command line, enter the following command to check how many times
you can run Sysprep in the displayed Windows Script Host dialog box:
slmgr /dlv
If the value of Remaining Windows rearm count is 0, you cannot run Sysprep.

2.8 What Do I Do If an ECS Created from a Windows
Image Failed to Start After Running Sysprep?

Symptom
1. After Sysprep is executed, the following message is displayed when you start

the ECS.
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Figure 2-3 Message displayed

Then, the following information is displayed in the dialog box:
Windows could not parse or process the unattend answer file for pass [specialize]. A 
component or setting specified in the answer file does not exist. The error was detected 
while processing settings for component [Microsoft-Windows-Shell-Setup].

2. Click OK. The following information is displayed in the dialog box:
The computer accidentally restarts or encounters an error. Windows installation cannot 
continue. Click OK to restart the computer and restart the installation.

3. Open setupact.log in C:\Windows\Panther. The log contains the following
information.

Figure 2-4 Viewing ECS logs

Solution
1. Create an ECS from a public image. (You are advised to use a public image to

create another ECS because Sysprep can be executed only for certain times.)
2. Create an Unattend.xml file or modify the Unattend.xml file provided by the

system.
– If you create an Unattend.xml file, ensure that the created file is used

when you run Sysprep. For details about the file, visit:

▪ https://docs.microsoft.com/en-us/windows-hardware/
manufacture/desktop/update-windows-settings-and-scripts-
create-your-own-answer-file-sxs

▪ https://docs.microsoft.com/en-us/windows-hardware/
manufacture/desktop/sysprep--system-preparation--overview

– If you modify the Unattend.xml file (in the C:\Program Files\Cloudbase
Solutions\Cloudbase-Init\conf directory), delete the RunSynchronous
part from the file.

Figure 2-5 Deleting the RunSynchronous part
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3. Run Sysprep. For details, see Running Sysprep.

NO TICE

If you use the Unattend.xml file created by yourself, check the Unattend.xml
path when running Sysprep to ensure that the newly created Unattend.xml
file is used.

4. Create an image from the ECS where Sysprep has been executed.

2.9 What Do I Do If I Cannot Create an Image in
ZVHD2 Format Using an API?

Symptom
When you create a ZVHD2 image using an API, the image is created in the ZVHD
format.

Solution
Check whether your token contains the op_gated_lld role (op_gated_lld is the
OBT tag, which can be viewed in the body of the response message of the API
used to obtain a user token). The ZVHD2 image has the lazy loading feature. If
the current environment does not support this feature or this feature is in the OBT
phase, the ZVHD2 image will fail to be created.

Contact the customer service to ensure that the current environment supports lazy
loading, obtain a new token, and use the new token to create an image.
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3 Image Sharing

3.1 Image Sharing FAQs

How Many Tenants Can I Share an Image with?
A system disk image or data disk image can be shared with up to 128 tenants, but
a full-ECS image can only be shared with up to 10 tenants.

How Many Images Can Be Shared with Me?
There is no limit.

Can I Share Images Between My Accounts at the Chinese Mainland Website
and International Website?

Yes. You can share images between your accounts of the Chinese Mainland and
International websites, but only in regions that are available on both websites. For
example, you cannot share images in the CN North-Beijing1 region of the Chinese
Mainland website with your account of the International website which does not
have this region.

Do Shared Images Affect My Private Image Quota?
No.

I Shared an Image to an Account But the Account Did Not Accept or Reject
the Image. Will My Image Sharing Quota Be Consumed?

No.

Where Can I View the Images Shared with Me?
Switch to the region where the shared image is located, choose Service List >
Compute > Image Management Service > Images Shared with Me.

If you are a multi-project user, make clear which of your projects will receive the
shared image. Switch to the region where the project resides and select the
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project. Then, choose Service List > Compute > Image Management Service >
Images Shared with Me.

If the image is not accepted, a red dot is displayed on the Images Shared with
Me tab page (as shown in Figure 3-1) and a message is displayed, asking you
whether to accept the shared image. After the image is accepted, it is displayed in
the list on the Images Shared with Me tab page.

Figure 3-1 Images Shared with Me

If I Want to Share a System Disk Image with Another Account, Should the
Account Purchase an ECS in Advance?

No. The account can use the shared image to apply for ECSs.

Is There Any Restriction on the Region When I Create ECSs Using a Shared
Image?

Yes. You can only create ECSs in the same region as the shared image.

Can I Share Images Shared with Me with Other Tenants?
You cannot directly share such images with other tenants. If you do need to do so,
you can replicate a shared image to a private image and then share the private
image.

Can I Use an Image I Have Shared with Others to Create an ECS?
Yes. After sharing an image with other tenants, you can still use the image to
create an ECS and use the created ECS to create a private image.

What Are the Risks of Creating ECSs Using a Shared Image?
The image owner can view, stop sharing, or delete the image at any time. After
the shared image is deleted, you will be unable to use the shared image to
reinstall the OSs of the ECSs created from the shared image or create ECSs with
the same configurations.

The cloud platform does not ensure the integrity or security of images shared by
other accounts. For security reasons, you are advised to choose only images shared
by trusted accounts.

What Are the Risks of Sharing Images with Other Tenants?
Data, files, and software may be disclosed. Before sharing an image, you must
take care to delete any sensitive data or important files from the image. The
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image recipient can use the shared image to create ECSs and use the created ECSs
to create private images. If the created private images are shared with other
tenants, any data leakage that occurs can be quite widespread.

How Do I Replicate an Image Between Projects in a Region?
Image sharing allows you to replicate images between projects in the same
region.

In the Share Image dialog box, enter target project IDs, and click OK, as
instructed in Sharing Specified Images. After the image is shared, switch to the
target projects. On the Image Management Service > Images Shared with Me
page, you can view the shared image to be accepted.

Can I Specify a Region or an AZ for Sharing an Image?
No. When sharing an image, you can only specify a project ID. You cannot specify
a region or an AZ. An image can only be shared within a given region, but once
shared, it can be used in any AZ in that region.

Can I Restore My Data Disks from a Data Disk Image Shared by Another
Account?

No. You can only use the shared image to apply for a new data disk and cannot
use it to restore your existing data disks. However, you can use the new data disk
for restoration by referring to Can I Import Data from a Data Disk Image to a
Data Disk?

Can I Share My ECS and Its EIP with Another Account?
You can share an ECS through full-ECS image sharing but cannot share the EIP.

What Can I Do If I Want to Use a Rejected Image?
If you have rejected an image shared by another tenant, but now want to use it,
two methods are available:

● Method 1
Ask the image owner to add you to the tenants the image is shared with. For
details, see Adding Tenants Who Can Use Shared Images.

● Method 2
Accept the rejected image again. For details, see Accepting Rejected Images.

3.2 How Will I Be Billed for Sharing an Image?
● If it is a system or data disk image, the OBS storage is free.
● If it is a full-ECS image, you will be billed for the space used to store the CBR

backup.

NO TE

Full-ECS images created from a CBR backup can be shared but those created from a
CSBS backup cannot.
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3.3 What Are the Differences Between Sharing Images
and Replicating Images?

● Sharing images:
You can only share images within a region with other users. To share an
image across regions, replicate the image to the target region and then share
it. For details, see Sharing Images.

● Replicating images:
– In-region: You can convert encrypted and unencrypted images into each

other or enable some advanced features (such as fast ECS creation from
an image) using the in-region image replication function.

The following table describes the details.

Scenario Opera
tion

Description Helpful Links

Sharing Share The image is shared with
another user in the same region.
The target user can use the
image (with the same ID as the
source image) but the image
owner is still the user who
shared it.

For details, see
Sharing Specified
Images.

In-region
replication
under the
same
account

Replica
te

This is used for conversion
between encrypted images and
unencrypted images or for
enabling advanced features
(such as fast ECS creation from
an image).

For details, see
Replicating Images
Within a Region.
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4 OS

4.1 How Do I Select an OS?
● Linux

Used for development platforms or services that run Linux. CentOS and
Ubuntu are provided. CentOS is recommended.
The system disk must be no less than 40 GB, and the memory must be no less
than 512 MB.

● OS selection for servers that require memory greater than 4 GB
Because 32-bit OSs allow addressing only within a 4 GB memory range, if the
required memory capacity is 4 GB or larger, select a 64-bit OS.

4.2 How Is BIOS Different from UEFI?

Table 4-1 Differences between the UEFI and BIOS boot modes

Boot
Mode

Description Highlight

BIOS Basic Input Output System
(BIOS) stores important basic
input/output programs of ECSs,
system settings, self-test
programs upon system startup,
and automatic startup programs.

Provides basic settings and control
for ECSs.

UEFI Unified Extensible Firmware
Interface (UEFI) is a specification
that defines a software interface
between an OS and platform
firmware. UEFI can be used to
automatically load an OS from a
pre-boot operating environment.

Boots up or recovers from sleep
state faster.
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4.3 How Do I Delete Redundant Network Connections
from a Windows ECS?

Method 1
1. Press Win+R. In the displayed dialog box, enter regedit and press Enter to

open the registry editor.
2. Open the following registry key:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT
\CurrentVersion\NetworkList\Profiles
Click each item under Profiles and query the Data column of ProfileName in
the right pane.

3. Double-click ProfileName and set Value Data to the name of a new
network.

4. Restart the ECS for the change to take effect.

Method 2
1. Press Win+R. In the displayed dialog box, enter regedit and press Enter to

open the registry editor.
2. Open the following registry keys:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT
\CurrentVersion\NetworkList\Profiles
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows NT
\CurrentVersion\NetworkList\Signatures\Unmanaged

3. Delete the directories shown in the following figure.
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Figure 4-1 Registry directory

4.4 What Do I Do If an ECS Starts Slowly?

Symptom

If an ECS starts slowly, you can change the default timeout duration to speed up
the startup.

Solution
1. Log in to the ECS.
2. Run the following command to switch to user root:

sudo su
3. Run the following command to query the version of the GRUB file:

rpm -qa | grep grub

Figure 4-2 Querying the GRUB file version

4. Set timeout in the GRUB file to 0.
– If the GRUB file version is earlier than 2:

Open /boot/grub/grub.cfg or /boot/grub/menu.lst and set timeout to
0.

– If the GRUB file version is 2:
Open /boot/grub2/grub.cfg and set the value of timeout to 0.
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Figure 4-3 Modifying the timeout duration

4.5 Why Can't I Find My Private Image When I Want to
Use It to Create an ECS or Change the OS of an ECS?

When you create an ECS or change the OS of an existing ECS, some of your
private images are not shown. One possible cause is that the x86 and Arm
architectures are incompatible with each other, or that there is an incompatibility
issue between UEFI and BIOS boot modes.

● If a private image is created from an x86 ECS or if you use an external image
file to create an image and select x86, this image will not be available as a
choice when you create an ARM (Kunpeng) ECS or change the OS of an ARM
(Kunpeng) ECS. Likewise, if the image is configured for ARM, it will not be
available as a choice when you create an x86 ECS or change the OS of an x86
ECS.

● If a private image is created from an ECS configured for BIOS boot or if you
use an external image file to create such an image, this image will not be
available as a choice when you create an ECS configured for UEFI boot or
change the OS of an ECS booted from UEFI. Likewise, images configured for
UEFI will not be available as a choice when you create an ECS configured for
BIOS boot or change the OS of an ECS booted from BIOS.
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5 Image Importing

5.1 Can I Use Images in Formats Other Than the
Specified Ones?

No. Currently, only the VMDK, VHD, RAW, QCOW2, VHDX, QED, VDI, QCOW,
ZVHD2, ISO, and ZVHD formats are supported.

Images of the -flat.vmdk format and image file packages containing snapshot
volumes or delta volumes are not supported. You can use qemu-img to convert
an image to one of the supported formats before uploading it to the cloud
platform.

NO TE

For details about image file format conversion, see Converting the Image Format Using
qemu-img.

5.2 What Are the Impacts If I Do Not Pre-configure an
ECS Used to Create a Private Image?

Before using an ECS or external image file to create a private image, you need to
pre-configure the ECS or the source VM of the image file. If you do not perform
the pre-configuration, there will be the following impacts:

1. If you do not delete residual rule files from the udev directory, new ECSs will
retain the configurations of the source ECS or image file. If you do not set the
IP address assignment mode to DHCP, NICs of new ECSs will not start from
eth0. You need to remotely log in to the new ECSs to perform configurations.

2. For Linux, the following issues may occur during the ECS creation:
– Custom passwords cannot be injected.
– Certificates cannot be injected.
– Other custom configurations cannot be applied on new ECSs.

3. If you do not delete information about automatic disk attachment detection
from the fstab file, new ECSs may fail to start.
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5.3 How Do I Import an OVF or OVA File to the Cloud
Platform?

Scenarios
Open Virtualization Appliance (OVA) is a single file (with the .ova extension) that
archives all the files making up an Open Virtualization Format (OVF). OVF is a
folder that contains the files required for defining and deploying VMs. An OVF
folder always includes .ovf, .mf, and .vmdk files.

● An .ovf file is an XML descriptor that defines metadata of a VM, such as the
name and hardware requirements, and contains reference information about
other files in the OVF folder.

● An .mf file contains the SHA hash codes of all the files in the folder and is
used to prevent the image file from being tampered with.

● A .vmdk file is a virtual disk file that is used to create a disk image. An OVF
folder may contain multiple .vmdk files.

This section describes how to import OVF and OVA files to the cloud platform.

Procedure
Manually extract VMDK files from an OVF or OVA template and upload them to
an OBS bucket. Then, you can select one from the bucket when you use an
external file to create a system or data disk image.

NO TE

The following assumes that the OVF or OVA template contains only one VMDK file. If there
are multiple VMDK files (for example, there are three VMDK files, one used as a system
disk image file and the others as data disk image files), upload them to an OBS bucket and
register them as a system disk image and data disk images, respectively.

● The source VM runs the Linux OS.
– If you choose to export an OVF template, upload the VMDK file

generated in the folder to the cloud platform.
– If you choose to export an OVA template and name it MyVm, perform

the following operations:

i. Run the following command to view the OVA file:
file MyVm.ova
The command output is as follows:
MyVm.ova: POSIX tar archive (GNU)

MyVm.ova contains the following two files:
$tar tf MyVm.ova
MyVm.ovf
MyVm.vmdk

ii. Run the following command to decompress MyVm.ova:
tar xvf MyVm.ova
The extracted folder contains the following files:
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MyVm.ovf
MyVm.vmdk

The image file in the VMDK format can be uploaded to the cloud
platform.

NO TE

You can import an image file in the VHD, VMDK, QCOW2, RAW, VHDX,
QCOW, VDI, QED, ZVHD, or ZVHD2 format to create a private image.

For details, see Creating a Linux System Disk Image Using an External
Image File or Creating a Data Disk Image Using an External Image File.

5.4 What Do I Do If I Configured an Incorrect OS or
System Disk Size During Private Image Registration
Using an Image File?

If you selected an incorrect OS, ECSs may fail to be created from the private
image. If the configured system disk size is less than the one in the image file,
image registration will fail.

In such cases, delete the incorrect image and create a new one using correct
parameter settings.

5.5 What Do I Do If the System Disk Size in a VHD
Image File Exceeds the One I Have Specified on the
Management Console When I Use This File to Register
a Private Image?

The possible causes may be:

1. You have specified a small value.

Check the system disk size in the VHD image file. Specify a value no less than
this size when you use the VHD image file to register an image.

2. The actual size of the VHD image file is larger than its virtual size, if this VHD
image file is generated using qemu-img or a similar tool. For details, see
https://bugs.launchpad.net/qemu/+bug/1490611.

Run the following command to check the VHD image file information:
[xxxx@xxxxx test]$ qemu-img info 2g.vhd
image: 2g.vhd
file format: vpc
virtual size: 2.0G (2147991552 bytes)
disk size: 8.0K
cluster_size: 2097152

The virtual size is converted from the actual size (unit: byte) to an integer in
GB. As a result, the actual file size 2147991552 bytes (2.0004 GB) is larger
than the virtual size 2 GB. Therefore, you need to specify a value larger than
the actual size 2.0004 GB. (The system disk size value on the management
can only be an integer, so you only need to enter a value larger than 2.)
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6 Image Exporting

6.1 Can I Download My Private Images to a Local PC?
Yes. You can download private images in VMDK, VHD, QCOW2, or ZVHD format
as instructed in Exporting an Image.

6.2 Can I Use the System Disk Image of an ECS on a
BMS After I Export It from the Cloud Platform?

No. The system disk image of an ECS is a VM file that contains a system running
environment and does not have an installation boot program. Therefore, it cannot
be used on a BMS.

6.3 Why Is the Image Size in an OBS Bucket Different
from That Displayed in IMS?

Symptom
After a private image is exported to an OBS bucket, the image size in the bucket is
different from that displayed in IMS. For example, the size of a private image is
1.04 GB on the IMS console. After it is exported to an OBS bucket, the size is
displayed as 2.91 GB.

Cause Analysis
The size of an image in an OBS bucket varies depending on the file's storage
format in the bucket.
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6.4 Can I Download a Public Image to My Local PC?
Currently, you cannot directly download a public image. You can use the public
image to create an ECS, use the ECS to create a private image, export the private
image to your OBS bucket, and download the private image to your local PC.

Helpful links:

● Creating a System Disk Image from a Linux ECS
● Exporting an Image

NO TE

● Ubuntu public images and the private images created from these public images cannot
be exported.

● However, if an Ubuntu private image is created from an external image file, this private
image can be exported.

6.5 What Are the Differences Between Import/Export
and Fast Import/Export?

Item Description Helpful Link

Import Import an external image file to the
HUAWEI CLOUD management console
for creating a private image.
External image files in the following
formats can be imported: VMDK, VHD,
QCOW2, RAW, VHDX, QED, VDI, QCOW,
ZVHD2, and ZVHD.
Maximum file size: 128 GB
During the import, operations such as
driver injection will be performed in the
background. Therefore, the import takes
a longer time than fast import.

● Creating a Linux
System Disk Image
from an External
Image File

● Creating a Data Disk
Image from an
External Image File
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Item Description Helpful Link

Fast
import

When importing an external image file
in the RAW or ZVHD2 format to the
HUAWEI CLOUD management console,
you can select Enable Fast Create. The
system does not perform any
operations such as driver injection.
Verify that:
● The image file converted to the RAW

format has been optimized as
required and a bitmap file has been
generated for it.

● The image file converted to the
ZVHD2 format has been optimized
as required.

Maximum file size: 1 TB

Quickly Importing an
Image File

Export You can export private images to OBS
buckets and download them to your
local PC for further use on other cloud
platforms.
Maximum file size: 128 GB (If an image
file is larger than 128 GB, use fast
export to export it.)
You can specify the format of the
exported image file. Currently, only
QCOW2, VMDK, VHD, and ZVHD are
supported.

Exporting an Image

Fast
export

On the Export Image page, select
Enable following Fast Export. You
cannot specify the format of the
exported image file. After the export is
complete, you can use a tool to convert
the exported image to your desired
format.
The file size is not limited.
Encrypted images do not support fast
export.

Exporting an Image

 

6.6 What Do I Do If the Export Option Is Unavailable
for My Image?

Some images cannot be exported. Therefore, the Export option is not provided for
them in the Operation column. The following images cannot be exported:

● Public images
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● Full-ECS images
● ISO images
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7 Image Optimization

7.1 Must I Install Guest OS Drivers on an ECS?
Installing Guest OS drivers on an ECS improves your experience in using the ECS.
In addition, it also ensures high reliability and stability of ECSs.

● Windows ECSs: Install the PV driver and UVP VMTools on ECSs.
● Linux ECSs: Install xen-pv and VirtIO drivers and load them in initrd.

7.2 Why Do I Need to Install and Update VMTools for
Windows?

Why Do I Need to Install VMTools?

VMTools is a VirtIO driver (para-virtualization driver) that provides high-
performance disks and NICs for ECSs.

● A standard Windows OS does not have the VirtIO driver.
● Public images have VMTools by default.
● You need to install VMTools for private images. For details, see Installing UVP

VMTools.

Why Do I Need to Update VMTools?

The cloud platform periodically synchronizes issue-fixed versions from the VirtIO
community and releases updated versions every month. This ensures that known
issues identified in the community or R&D tests can be avoided on the latest
driver.

When Do I Need to Update VMTools?
● If a major error is fixed, you are advised to update VMTools immediately.

(Major errors have not occurred by now.) If other issues are fixed, choose
whether to update VMTools based on your needs.
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● The cloud platform updates the VMTools stored in an OBS bucket on a
regular basis to ensure that you can download the latest version of VMTools
for private images.

● The cloud platform updates public images on a regular basis to ensure that
these images have the latest version of VMTools.

● The document is updated on a regular basis in accordance with VMTools in an
OBS bucket to ensure that the download link of VMTools provided in the
document is the latest.

What Do I Need to Do After VMTools Is Updated?
● Update Windows private images or drivers in running Windows ECSs.

● If you have any technical issue or question, contact the customer service.

7.3 What Will the System Do to an Image File When I
Use the File to Register a Private Image?

You are advised to enable automatic configuration when registering a private
image using an image file. Then, the system will perform the following operations:

Linux
● Check whether any PV drivers exist. If yes, the system deletes them.

● Modify the grub and syslinux configuration files to add the OS kernel boot
parameters and change the disk partition name (UUID=UUID of the disk
partition).

● Change the names of the disk partitions in the /etc/fstab file (UUID=UUID of
the disk partition).

● Check whether the initrd file has the Xen and IDE drivers. If no, the system
will load the Xen and IDE drivers.

● Modify the X Window configuration file /etc/X11/xorg.conf to prevent display
failures.

● Delete services of VMware tools.

● Record the latest automatic modification made to the image into /var/log/
rainbow_modification_record.log.

● Copy the built-in VirtIO driver to initrd or initramfs. For details, see External
Image File Formats and Supported OSs.

NO TE

For the following image files, the system does not copy this driver after Enable automatic
configuration is selected:

● Image files whose /usr directory is an independent partition

● Fedora 29 64bit, Fedora 30 64bit, and CentOS 8.0 64bit image files that use the XFS file
system

● SUSE 12 SP4 64bit image files that use the ext4 file system

Image Management Service
FAQs 7 Image Optimization

Issue 02 (2023-08-10) Copyright © Huawei Technologies Co., Ltd. 33

https://support.huaweicloud.com/eu/productdesc-ims/en-us_topic_0030713143.html
https://support.huaweicloud.com/eu/productdesc-ims/en-us_topic_0030713143.html


7.4 How Do I Configure an ECS, BMS, or Image File
Before I Use It to Create an Image?

ECS or Image File Configurations

Table 7-1 ECS configurations

OS Configuration Reference

Linux ● Set the NIC to DHCP.
● Install the one-click password

reset plug-in.
● (Optional) Install Cloud-Init.
● Delete files from the network

rule directory.
● Change the disk identifier in

the GRUB configuration file to
UUID.

● Change the disk identifier in
the fstab file to UUID.

● Install native Xen and KVM
drivers.

● Detach data disks from the ECS.

Creating a System Disk
Image from a Linux ECS
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Table 7-2 Image file configurations

OS Configuration Reference

Linux ● Delete files from the network
rule directory.

● Set the NIC to DHCP.
● Install native Xen and KVM

drivers.
● Change the disk identifier in

the GRUB configuration file to
UUID.

● Change the disk identifier in
the fstab file to UUID.

● Delete the automatic
attachment information of
non-system disks from
the /etc/fstab file.

● (Optional) Install Cloud-Init.
● (Optional) Enable NIC multi-

queue.
● (Optional) Configure an IPv6

address.

Preparing an Image File
(Linux)

 

NO TE

● When registering an external image file as a private image, you are advised to perform
the preceding operations on the VM where the external image file is located.

● When registering a Windows external image file as a private image, if the Guest OS
drivers are installed, the cloud platform will check the image file after you select Enable
automatic configuration. If the GuestOS drivers are not installed, the cloud platform
will try to install them.

BMS or Image File Configurations

Table 7-3 BMS configurations

OS Configuration Reference

Windows ● Install software in the bms-
network-config package.

● Install Cloudbase-Init.
● Delete residual files from the

OS.

Creating a Private Image
from a BMS
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OS Configuration Reference

Linux ● Install software in the bms-
network-config package.

● Install Cloud-Init.
● Delete residual files from the

OS.

Creating a Private Image
from a BMS

 

Table 7-4 Image file configurations

OS Configuration Reference

Windows ● Install drivers for x86 V5 BMSs.
● Install Cloudbase-Init.
● Install software in the bms-

network-config package.
● (Optional) Install the SDI iNIC

driver.
● (Optional) Install the one-click

password reset plug-in.
● Set the Windows time zone.
● Set the virtual memory.
● (Optional) Configure automatic

Windows update.
● Configure SID.

Private Image Creation
Guide
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OS Configuration Reference

Linux ● Install and configure Cloud-Init.
● Modify the hardware device

driver that boots the OS.
● Install software in the bms-

network-config package.
● (Optional) Install the SDI iNIC

driver.
● (Optional) Install the Hi1822

NIC driver.
● (Optional) Install the IB driver.
● (Optional) Install drivers for

x86 V5 BMSs.
● (Optional) Install the UltraPath

software.
● (Optional) Install the one-click

password reset plug-in.
● Perform security configuration.
● Configure remote login to the

BMS.
● Configure automatic root

partition expansion.

Private Image Creation
Guide

 

7.5 What Do I Do If a Windows Image File Is Not Pre-
Configured When I Use It to Register a Private Image?

If an image file is not configured as instructed in Windows image file
requirements before it is exported from the original platform, configure it by
referring to Figure 7-1.

CA UTION

The proper running of ECSs depends on the Xen Guest OS driver (PV driver) and
KVM Guest OS driver (UVP VMTools), without which the performance of ECSs will
be affected and some functions will be unavailable. Ensure that the driver
installation has been completed for the image file before it is exported from the
original platform. Otherwise, the ECSs created from the image will fail to start.
● Install the PV driver. For details, see Installing the PV Driver.
● Install UVP VMTools. For details, see Installing UVP VMTools.
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Figure 7-1 Image creation process

Step 1: Upload the Image File
Upload the external image file to an OBS bucket. For details, see Uploading an
External Image File (Windows).

Step 2 Register the Image File as a Private Image
On the management console, select the uploaded image file and register it as a
private image. For details, see Registering an External Image File as a Private
Image (Windows).

Step 3: Create an ECS
1. Access the IMS console.

a. Log in to the management console.
b. Under Compute, click Image Management Service.

The IMS console is displayed.
2. Click the Private Images tab.
3. Locate the row that contains the private image and click Apply for Server in

the Operation column.
4. Set parameters as promoted to create an ECS. Pay attention to the following:

– You are advised to select Pay-per-use for Billing Mode because the ECS
will be deleted when you finish with it.

– Bind an EIP to the ECS so that you can upload installation packages to
the ECS or download installation packages from the ECS.

– You must add inbound rules for security groups of the ECS to ensure that
the ECS can be accessed.

Image Management Service
FAQs 7 Image Optimization

Issue 02 (2023-08-10) Copyright © Huawei Technologies Co., Ltd. 38

https://support.huaweicloud.com/eu/usermanual-ims/ims_01_0205.html
https://support.huaweicloud.com/eu/usermanual-ims/ims_01_0205.html
https://support.huaweicloud.com/eu/usermanual-ims/ims_01_0206.html
https://support.huaweicloud.com/eu/usermanual-ims/ims_01_0206.html


– If the image file has Cloudbase-Init installed, set a password and log in to
the ECS using the password as prompted. If Cloudbase-Init is not
installed, use the password or certificate contained in the image file to
log in the ECS.

For details, see Purchasing an ECS.
5. Perform the following steps to check whether the private image has been pre-

configured:

a. Check whether the ECS can be successfully started. If the start succeeds, a
Guest OS driver has been installed for the image file on the original
platform or the driver has been automatically installed for the private
image on the cloud platform. If the start failed, install a Guest OS driver
for the image file on the original platform and start from Step 1: Upload
the Image File again.

b. Check whether you can log in to the ECS using your configured password
or key. If you can, Cloudbase-Init has been installed. If you cannot, use
the password or key contained in the image file to log in to the ECS and
install Cloudbase-Init as instructed in Installing and Configuring
Cloudbase-Init.

c. Check whether NICs are set to DHCP by referring to 2 in Step 4:
Configure the ECS.

d. Use MSTSC to log in to the ECS. If the login is successful, remote desktop
connection is enabled on the ECS. If the login fails, enable remote
desktop connection by referring to 3 in Step 4: Configure the ECS.

If the ECS meets the preceding requirements, the private image has been pre-
configured. Skip Step 4: Configure the ECS and Step 5: Create a Private
Image from the ECS.

Step 4: Configure the ECS

Remotely log in to the ECS created in Step 3: Create an ECS to configure it.

1. Log in to the ECS.
2. Check whether NICs are set to DHCP. If the ECS is configured with a static IP

address, change its IP address assignment mode to DHCP as instructed in
Setting the NIC to DHCP.

3. Enable remote desktop connection for the ECS as needed. For details about
how to enable this function, see Enabling Remote Desktop Connection.

4. (Optional) Configure value-added functions.
– Install and configure Cloudbase-Init. For details, see Installing and

Configuring Cloudbase-Init.
– Enable NIC multi-queue. For details, see How Do I Enable NIC Multi-

Queue for an Image?
– Configure an IPv6 address. For details, see How Do I Configure an ECS

to Dynamically Acquire IPv6 Addresses?

Step 5: Create a Private Image from the ECS

For details, see Creating a System Disk Image from a Windows ECS.
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(Optional) Clear the Environment
After the image registration is complete, delete the image file as well as the
intermediate private image and ECS to avoid generating any additional charges.

● Delete the image registered in Step 2 Register the Image File as a Private
Image.

● Delete the ECS created in Step 3: Create an ECS.
● Delete the image file from the OBS bucket.

7.6 What Do I Do If a Linux Image File Is Not Pre-
Configured When I Use It to Register a Private Image?

If an image file is not configured as instructed in Linux image file requirements
before it is exported from the original platform, configure it by referring to Figure
7-2.

CA UTION

The proper running of ECSs depends on the Xen or KVM driver. If no such a driver
is installed, the performance of ECSs will be affected and some functions will be
unavailable. Ensure that the KVM driver has been installed for the image file
before it is exported from the original platform. Otherwise, the ECSs created from
the image will fail to start.
● For Xen, install native Xen and KVM drivers. For details, see How Do I Install

the Native Xen and KVM Drivers?.
● For KVM, install native KVM drivers. For details, see Installing Native KVM

Drivers.
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Figure 7-2 Image creation process

Step 1: Upload the Image File

Upload the external image file to an OBS bucket. For details, see Uploading an
External Image File (Linux).

Step 2 Register the Image File as a Private Image

On the management console, select the uploaded image file and register it as a
private image. For details, see Registering an External Image File as a Private
Image (Linux).

Step 3: Create an ECS

Create an ECS from the private image.

1. Access the IMS console.

a. Log in to the management console.
b. Under Compute, click Image Management Service.

The IMS console is displayed.
2. Click the Private Images tab.
3. Locate the row that contains the private image and click Apply for Server in

the Operation column.
4. Set parameters as promoted to create an ECS. Pay attention to the following:

– You are advised to select Pay-per-use for Billing Mode because the ECS
will be deleted when you finish with it.

– You must add inbound rules for security groups of the ECS to ensure that
the ECS can be accessed.
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– If Cloud-Init has been installed in the image file, set a login password as
prompted. If Cloud-Init is not installed, use the password or certificate
contained in the image file to log in.

For details, see Purchasing an ECS.
5. Perform the following steps to check whether the private image has been pre-

configured:

a. Check whether the ECS can be successfully started. If the start succeeds,
the Xen or KVM driver has been installed for the external image file on
the original platform or the driver has been automatically installed for
the private image on the cloud platform. If the start failed, install the Xen
or KVM driver as needed for the image file and start from Step 1:
Upload the Image File again.

b. Check whether you can log in to the ECS using your configured password
or key. If you can, Cloud-Init has been installed. If you cannot, use the
password or key contained in the image file to log in to the ECS and
install Cloud-Init as instructed in Installing Cloud-Init.

c. Check the network configuration by referring to Step 4: Configure the
ECS.

If the ECS meets the preceding requirements, the private image has been pre-
configured. Skip Step 4: Configure the ECS and Step 5: Create a Private
Image from the ECS.

Step 4: Configure the ECS

Remotely log in to the ECS created in Step 3: Create an ECS to configure it.

1. Log in to the ECS.
2. Configure the network.

– Run the ifconfig command to check whether the private IP address of the
ECS is the same as that displayed on the console. If they are inconsistent,
delete files from the network rule directory as instructed in Deleting
Files from the Network Rule Directory.

– Check whether NICs are set to DHCP. If the ECS is configured with a static
IP address, change its IP address assignment mode to DHCP as instructed
in Setting the NIC to DHCP.

– Run the service sshd status command to check whether SSH is enabled.
If it is disabled, run the service sshd start command to enable it. Ensure
that your firewall (for example, Linux iptables) allows SSH access.

3. Configure a file system.
– Change the disk identifier in the GRUB configuration file to UUID. For

details, see Changing the Disk Identifier in the GRUB Configuration
File to UUID.

– Change the disk identifier in the fstab file to UUID. For details, see
Changing the Disk Identifier in the fstab File to UUID.

– Clear the automatic attachment information of non-system disks in
the /etc/fstab file to prevent impacts on subsequent data disk
attachment. For details, see Detaching Data Disks from an ECS.

4. (Optional) Configure value-added functions.
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– Install and configure Cloud-Init. For details, see Installing Cloud-Init and
Configuring Cloud-Init.

– Enable NIC multi-queue. For details, see How Do I Enable NIC Multi-
Queue for an Image?

– Configure an IPv6 address. For details, see How Do I Configure an ECS
to Dynamically Acquire IPv6 Addresses?

Step 5: Create a Private Image from the ECS

Create a private image from the ECS. For details, see Creating a System Disk
Image from a Linux ECS.

(Optional) Clear the Environment

After the image registration is complete, delete the image file as well as the
intermediate private image and ECS to avoid generating any additional charges.

● Delete the image registered in Step 2 Register the Image File as a Private
Image.

● Delete the ECS created in Step 3: Create an ECS.
● Delete the image file from the OBS bucket.

7.7 How Do I Enable NIC Multi-Queue for an Image?

Scenarios

With the increase of network I/O bandwidth, a single vCPU cannot meet the
requirement of processing NIC interruptions. NIC multi-queue allows multiple
vCPUs to process NIC interruptions, thereby improving network PPS and I/O
performance.

ECSs Supporting NIC Multi-Queue

NIC multi-queue can be enabled on an ECS only when the ECS specifications,
virtualization type, and image meet the requirements described in this section.

● For details about the ECS specifications that support NIC multi-queue, see ECS
Types.

NO TE

If the number of NIC queues is greater than 1, NIC multi-queue is supported.

● Only KVM ECSs support NIC multi-queue.
● The Linux public images listed in Table 7-5 support NIC multi-queue.

NO TE

● You are advised to upgrade the kernel version of Linux ECSs to 2.6.35 or later.
Otherwise, NIC multi-queue is not supported.

Run the uname -r command to check the kernel version. If the version is earlier
than 2.6.35, contact technical support to upgrade it.
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Table 7-5 Linux ECSs that support NIC multi-queue

OS Image Supported By NIC Multi-
Queue
Enabled by
Default

Linux Ubuntu 14.04/16.04 Server
64bit

Public images Yes

openSUSE 42.2 64bit Public images Yes

SUSE Enterprise 12 SP1/SP2
64bit

Public images Yes

CentOS
6.8/6.9/7.0/7.1/7.2/7.3/7.4/7.5/7.
6 64bit

Public images Yes

Debian 8.0.0/8.8.0/8.9.0/9.0.0
64bit

Public images Yes

Fedora 24/25 64bit Public images Yes

EulerOS 2.2 64bit Public images Yes

 

Operation Instructions
Assume that an ECS has the required specifications and virtualization type.

● If the ECS was created using a public image listed in ECSs Supporting NIC
Multi-Queue, NIC multi-queue has been enabled on the ECS by default.
Therefore, you do not need to manually enable NIC multi-queue for it.

● If the ECS was created using an external image file with an OS listed in ECSs
Supporting NIC Multi-Queue, perform the following operations to enable
NIC multi-queue:

a. Register the External Image File as a Private Image.
b. Set NIC Multi-Queue for the Image.
c. Create an ECS from the Private Image.
d. Run the Script for Configuring NIC Multi-Queue.

Register the External Image File as a Private Image
For details, see Registering an External Image File as a Private Image (Linux).
After the image file is imported, view the value of NIC Multi-Queue on the page
providing details about the image.
● If the value is Supported, go to Create an ECS from the Private Image.
● If the value is Not supported, go to Set NIC Multi-Queue for the Image.

Set NIC Multi-Queue for the Image
Use either of the following methods to set NIC multi-queue.
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Method 1:

1. Access the IMS console.

a. Log in to the management console.
b. Under Compute, click Image Management Service.

The IMS console is displayed.
2. On the displayed Private Images page, locate the row that contains the

target image and click Modify in the Operation column.
3. Set NIC multi-queue for the image.

Method 2:

1. Access the IMS console.

a. Log in to the management console.
b. Under Compute, click Image Management Service.

The IMS console is displayed.
2. On the displayed Private Images page, click the name of the target image.
3. In the upper right corner of the displayed image details page, click Modify. In

the displayed Modify Image dialog box, set NIC multi-queue for the image.

Method 3: Add hw_vif_multiqueue_enabled to the image using an API.

1. Obtain a token. For details, see Authentication.
2. Call an API to update image information. For details, see Updating Image

Information (Native OpenStack API).
3. Add X-Auth-Token to the request header.

The value of X-Auth-Token is the token obtained in step 1.
4. Add Content-Type to the request header.

The value of Content-Type is application/openstack-images-v2.1-json-
patch.
The request URI is in the following format:
PATCH /v2/images/{image_id}
The request body is as follows:
[       
         { 
          "op":"add",
          "path":"/hw_vif_multiqueue_enabled", 
          "value": "true" 
         } 
 ]

Figure 7-3 shows an example request body for setting NIC multi-queue.
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Figure 7-3 Example request body

Create an ECS from the Private Image

Use the registered private image to create an ECS. For details, see Purchasing an
ECS. Note the following when setting the parameters:
● Region: Select the region where the private image is located.
● Image: Select Private image and then the desired image from the drop-down

list.

Run the Script for Configuring NIC Multi-Queue

For Linux OSs, the script for automatically configuring NIC multi-queue is
provided. If an ECS has multiple NICs, running the script will automatically enable
multi-queue for all the NICs.

1. Log in to the ECS and run the following command to check the number of
queues supported by and enabled for a NIC:
ethtool -l NIC
Example:
[root@localhost ~]# ethtool -l eth0   #View the number of queues used by NIC eth0.
Channel parameters for eth0:
Pre-set maximums:
RX:               0
TX:               0
Other:            0
Combined:         4   #The NIC supports a maximum of four queues.
Current hardware settings:
RX:               0
TX:               0
Other:            0
Combined:         1   #One queue has been enabled for the NIC.

If the values of the two Combined fields are the same, NIC multi-queue has
been enabled. No further action is required.

2. Run the following command to download the configuration script multi-
queue-hw:
wget https://ecs-instance-driver.obs.cn-north-1.myhuaweicloud.com/
multi-queue-hw
The download path is https://ecs-instance-driver.obs.cn-
north-1.myhuaweicloud.com/multi-queue-hw.
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3. Run the following command to make the script executable:
chmod +x multi-queue-hw

4. Run the following command to place the multi-queue-hw script in the /etc/
init.d directory:
mv multi-queue-hw /etc/init.d
Enter y when the following information is displayed:
mv: overwrite '/etc/init.d/multi-queue-hw'?

5. Run the following command to run the script:
/etc/init.d/multi-queue-hw start
NIC multi-queue script takes effect immediately after the script is executed
but becomes invalid once the ECS stops.

6. Add a startup item for each OS so that NIC multi-queue is automatically
enabled upon the ECS startup.
– For CentOS, Red Hat, Fedora, EulerOS, SUSE, and openSUSE, run the

following command:
chkconfig multi-queue-hw on

– For Ubuntu, run the following command:
update-rc.d multi-queue-hw defaults 90 10

– For Debian, run the following command:
systemctl enable multi-queue-hw

7.8 How Do I Configure an ECS to Dynamically Acquire
IPv6 Addresses?

Scenarios

IPv6 addresses are used to deal with IPv4 address exhaustion. If an ECS uses an
IPv4 address, the ECS can run in dual-stack mode after IPv6 is enabled for it. Then,
the ECS will have two IP addresses to access the intranet and Internet: an IPv4
address and an IPv6 address.

In some cases, an ECS cannot dynamically acquire an IPv6 address even if it meets
all the requirements in Constraints. You need to configure the ECS to dynamically
acquire IPv6 addresses. For public images:

● Before enabling dynamic IPv6 address assignment for a Linux public image,
check whether IPv6 has been enabled and then whether dynamic IPv6 address
assignment has been enabled. Currently, IPv6 is enabled for all Linux public
images.

Constraints
● Ensure that IPv6 has been enabled on the subnet where the ECS works.

For details about how to enable IPv6 on a subnet, see Enabling IPv6 on the
Subnet Where the ECS Works.

● Ensure that the ECS flavor supports IPv6.
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The ECS flavors that support IPv6 vary depending on regions and AZs. Check
whether an ECS flavor supports IPv6 after you select a region and AZ on the
management console.
If the value of IPv6 is Yes for an ECS flavor, the flavor supports IPv6.

NO TE

AZ and Flavor determine whether IPv6 is supported.

After you select an AZ, if IPv6 is not displayed or the value of IPv6 is No, IPv6 is not
supported by any or certain flavors in the AZ.

● Ensure that Self-assigned IPv6 address is selected during ECS creation.
● After the ECS is started, its hot-swappable NICs cannot automatically acquire

IPv6 addresses.
● Only ECSs can work in dual-stack mode and BMSs cannot.
● Only one IPv6 address can be bound to a NIC.

Procedure
● Linux: Dynamic assignment of IPv6 addresses can be enabled automatically

(recommended) or manually.
If a private image created from a CentOS 6.x or Debian ECS with automatic
IPv6 address assignment enabled is used to create an ECS in an environment
that does not support IPv6, the ECS may start slow because of IPv6 address
assignment timeout. You can set the timeout duration for assigning IPv6
addresses by referring to Setting the Timeout Duration for IPv6 Address
Assignment.

Table 7-6 Enabling dynamic assignment of IPv6 addresses for different OSs

OS Automatically/
Manually Enabling

Reference

Linux Automatically
(recommended)

Linux (Automatically
Enabling Dynamic
Assignment of IPv6
Addresses)

Linux Manually Linux (Manually Enabling
Dynamic Assignment of IPv6
Addresses)

 

Enabling IPv6 on the Subnet Where the ECS Works
1. Log in to the management console.

2. Click  in the upper left corner and select the desired region and project.

3. Click . Under Compute, click Elastic Cloud Server.
4. Click the target ECS to go to the detail page.
5. In the ECS Information area, click the VPC name.
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6. Click the number in the Subnets column.
The Subnets page is displayed.

7. In the subnet list, locate the target subnet and click its name.
The subnet details page is displayed.

8. In the Subnet Information area, click Enable for IPv6 CIDR Block.
9. Click Yes.

Linux (Automatically Enabling Dynamic Assignment of IPv6 Addresses)

The ipv6-setup-xxx tool can be used to enable Linux OSs to automatically acquire
IPv6 addresses. xxx indicates a tool, which can be rhel or debian.

You can also enable dynamic IPv6 address assignment by following the
instructions in Linux (Manually Enabling Dynamic Assignment of IPv6
Addresses).

CA UTION

● When you run ipv6-setup-xxx, the network service will be automatically
restarted. As a result, the network is temporarily disconnected.

● If a private image created from a CentOS 6.x or Debian ECS with automatic
IPv6 address assignment enabled is used to create an ECS in an environment
that does not support IPv6, the ECS may start slow because of IPv6 address
assignment timeout. Set the timeout duration for assigning IPv6 addresses to
30s by referring to Setting the Timeout Duration for IPv6 Address
Assignment and try to create a new private image again.

Step 1 Run the following command to check whether IPv6 is enabled for the ECS:

ip addr

● If only an IPv4 address is displayed, IPv6 is disabled. Enable it by referring to
Setting the Timeout Duration for IPv6 Address Assignment.

Figure 7-4 IPv6 disabled

● If a link-local address (starting with fe80) is displayed, IPv6 is enabled but
dynamic assignment of IPv6 addresses is not enabled.

Figure 7-5 IPv6 enabled

● If the following address is displayed, IPv6 is enabled and an IPv6 address has
been assigned:
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Figure 7-6 IPv6 enabled and an IPv6 address assigned

NO TE

IPv6 is enabled for Linux public images by default, as shown in Figure 7-5.

Step 2 Enable IPv6 for the ECS.

1. Run the following command to check whether IPv6 is enabled for the kernel:
sysctl -a | grep ipv6
– If a command output is displayed, IPv6 is enabled.
– If no information is displayed, IPv6 is disabled. Go to Step 2.2 to load the

IPv6 module.
2. Run the following command to load the IPv6 module:

modprobe ipv6
3. Add the following content to the /etc/sysctl.conf file:

net.ipv6.conf.all.disable_ipv6=0
4. Save the configuration and exit. Then, run the following command to load the

configuration:
sysctl -p

Step 3 Enable dynamic IPv6 address assignment for the ECS.

1. Download ipv6-setup-rhel or ipv6-setup-debian with a required version and
upload it to the target ECS.
ipv6-setup-xxx modifies the configuration file of a NIC to enable dynamic
IPv6 address assignment or adds such a configuration file for a NIC, and then
restarts the NIC or network service. Table 7-7 lists the download paths of
ipv6-setup-rhel and ipv6-setup-debian.

Table 7-7 Download paths of ipv6-setup-rhel and ipv6-setup-debian

Series Release Version How to Obtain

RHEL – CentOS 6/7
– EulerOS 2.2/2.3
– Fedora 25

https://ecs-instance-
driver.obs.cn-
north-1.myhuaweicloud.com/
ipv6/ipv6-setup-rhel

Debian – Ubuntu 16/18/20
– Debian 8/9/10

https://ecs-instance-
driver.obs.cn-
north-1.myhuaweicloud.com/
ipv6/ipv6-setup-debian

 
2. Run the following command to make ipv6-setup-xxx executable:

chmod +x ipv6-setup-xxx
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3. Run the following command to enable dynamic IPv6 address assignment for a
NIC:

./ipv6-setup-xxx --dev [dev]

Example:

./ipv6-setup-xxx --dev eth0

NO TE

– To enable dynamic IPv6 address assignment for all NICs, run the ./ipv6-setup-xxx
command.

– To learn how to use ipv6-setup-xxx, run the ./ipv6-setup-xxx --help command.

----End

Linux (Manually Enabling Dynamic Assignment of IPv6 Addresses)

CA UTION

If a private image created from a CentOS 6.x or Debian ECS with automatic IPv6
address assignment enabled is used to create an ECS in an environment that does
not support IPv6, the ECS may start slow because of IPv6 address assignment
timeout. Set the timeout duration for assigning IPv6 addresses to 30s by referring
to Setting the Timeout Duration for IPv6 Address Assignment and try to create
a new private image again.

Step 1 Run the following command to check whether IPv6 is enabled for the ECS:

ip addr

● If only an IPv4 address is displayed, IPv6 is disabled. Enable it by referring to
Step 2.

Figure 7-7 IPv6 disabled

● If a link-local address (starting with fe80) is displayed, IPv6 is enabled but
dynamic assignment of IPv6 addresses is not enabled.

Figure 7-8 IPv6 enabled

● If the following address is displayed, IPv6 is enabled and an IPv6 address has
been assigned:
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Figure 7-9 IPv6 enabled and an IPv6 address assigned

NO TE

IPv6 is enabled for Linux public images by default, as shown in Figure 7-8.

Step 2 Enable IPv6 for the ECS.
1. Run the following command to check whether IPv6 is enabled for the kernel:

sysctl -a | grep ipv6
– If a command output is displayed, IPv6 is enabled.
– If no information is displayed, IPv6 is disabled. Go to Step 2.2 to load the

IPv6 module.
2. Run the following command to load the IPv6 module:

modprobe ipv6
3. Add the following content to the /etc/sysctl.conf file:

net.ipv6.conf.all.disable_ipv6=0
4. Save the configuration and exit. Then, run the following command to load the

configuration:
sysctl -p

Step 3 Enable dynamic IPv6 address assignment for the ECS.
● Ubuntu 18.04/20.04

a. Run the following command to access /etc/netpaln/:
cd /etc/netplan

b. Run the following command to list the configuration file:
ls

Figure 7-10 Configuration file name

c. Run the following command to edit the configuration file:
vi 01-network-manager-all.yaml

d. Append the following content to the configuration file (pay attention to
the yaml syntax and text indentation):
ethernets:
 eth0:
  dhcp6: true

Figure 7-11 Edited configuration file
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Save the changes and exit.
e. Run the following command to make the changes take effect:

sudo netplan apply
● Ubuntu 22.04

a. Run the following command to access /etc/netpaln/:
cd /etc/netplan

b. Run the following command to list the configuration file:
ls

Figure 7-12 Configuration file name

c. Run the following command to edit the configuration file:
vi 01-netcfg.yaml

d. Append the following content to the configuration file (pay attention to
the yaml syntax and text indentation):
ethernets:
 eth0:
  dhcp6: true

Figure 7-13 Edited configuration file

Save the changes and exit.
e. Run the following command to make the changes take effect:

sudo netplan apply
● Debian

a. Add the following content to the /etc/network/interfaces file:
auto lo 
iface lo inet loopback 
auto eth0
iface eth0 inet dhcp
iface eth0 inet6 dhcp 
     pre-up sleep 3
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b. Add configurations for each NIC to the /etc/network/interfaces file. The
following uses eth1 as an example:
auto eth1
iface eth1 inet dhcp
iface eth1 inet6 dhcp 
     pre-up sleep 3

c. Run the following command to restart the network service:
service networking restart

NO TE

If no IPv6 address is assigned after the NICs are brought down and up, you can
run this command to restart the network.

d. Perform Step 1 to check whether dynamic IPv6 address assignment is
enabled.

● CentOS, EulerOS, or Fedora
a. Open the configuration file /etc/sysconfig/network-scripts/ifcfg-eth0 of

the primary NIC.
Add the following configuration items to the file:
IPV6INIT=yes
DHCPV6C=yes

b. Edit the /etc/sysconfig/network file to add or modify the following line:
NETWORKING_IPV6=yes

c. For an ECS running CentOS 6, you need to edit the configuration files of
its extension NICs. For example, if the extension NIC is eth1, you need to
edit /etc/sysconfig/network-scripts/ifcfg-eth1.
Add the following configuration items to the file:
IPV6INIT=yes
DHCPV6C=yes

In CentOS 6.3, dhcpv6-client requests are filtered by ip6tables by default.
So, you also need to add a rule allowing the dhcpv6-client request to the
ip6tables file.
i. Run the following command to add the rule to ip6tables:

ip6tables -A INPUT -m state --state NEW -m udp -p udp --dport
546 -d fe80::/64 -j ACCEPT

ii. Run the following command to save the rule in ip6tables:
service ip6tables save

Figure 7-14 Example command

d. (Optional) For CentOS 7/CentOS 8, change the IPv6 link-local address
mode of extension NICs to EUI64.
i. Run the following command to query the NIC information:

nmcli con

Figure 7-15 Querying NIC information
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ii. Run the following command to change the IPv6 link-local address
mode of eth1 to EUI64:
nmcli con modify "Wired connection 1" ipv6.addr-gen-mode eui64

NO TE

The NIC information varies depending on the CentOS series. In the
command, Wired connection 1 needs to be replaced with the value in the
NAME column of the queried NIC information.

iii. Run the following commands to bring eth1 down and up:
ifdown eth1
ifup eth1

e. Restart the network service.

i. For CentOS 6, run the following command to restart the network
service:
service network restart

ii. For CentOS 7/EulerOS/Fedora, run the following command to restart
the network service:
systemctl restart NetworkManager

f. Perform Step 1 to check whether dynamic IPv6 address assignment is
enabled.

● SUSE, openSUSE, or CoreOS
SUSE 11 SP4 does not support dynamic IPv6 address assignment.
No additional configuration is required for SUSE 12 SP1 or SUSE 12 SP2.
No additional configuration is required for openSUSE 13.2 or openSUSE 42.2.
No additional configuration is required for CoreOS 10.10.5.

----End

Setting the Timeout Duration for IPv6 Address Assignment

After automatic IPv6 address assignment is configured on an ECS running CentOS
6.x or Debian, the ECS will be created as a private image. When this image is used
to create an ECS in an environment that IPv6 is unavailable, the ECS may start
slow because acquiring an IPv6 address times out. Before creating the private
image, you can set the timeout duration for acquiring IPv6 addresses to 30s as
follows:

● CentOS 6.x:

a. Run the following command to edit the dhclient.conf file:
vi /etc/dhcp/dhclient.conf

b. Press i to enter editing mode and add the timeout attribute to the file.
timeout  30;

c. Enter :wq to save the settings and exit.
● Debian 7.5:

a. Run the following command to edit the networking file:
vi /etc/init.d/networking
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b. Press i to enter editing mode and add the timeout attribute.

Figure 7-16 Modification 1

Figure 7-17 Modification 2

● Debian 8.2.0/8.8.0

a. Run the following command to edit the network-pre.conf file:

vi /lib/systemd/system/networking.service.d/network-pre.conf

b. Press i to enter editing mode and add the timeout attribute to the file.
[Service]
TimeoutStartSec=30

● Debian 9.0

a. Run the following command to edit the networking.service file:

vi /etc/system/system/network-online.target.wants/
networking.service

b. Press i to enter editing mode and change TimeoutStartSec=5min to
TimeoutStartSec=30.
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7.9 How Do I Clean Up the Disk Space of a Windows
ECS?

Scenarios

To clean up the disk space of a Windows ECS, you need to perform the following
operations.

Disable Virtual Memory

Some disk space of an ECS serves as virtual memory which can be used when the
ECS memory is exhausted. However, when the memory usage is high, frequent
switching between the memory and virtual memory causes a large number of
extra I/Os, which deteriorates the I/O performance. Therefore, you can disable
virtual memory to free up disk space on Windows.

An ECS running Windows Server 2008 R2 Standard 64-bit is used as an example to
describe how to disable virtual memory.

1. Right-click the Computer icon and choose Properties. In the displayed
window, click Advanced System Settings.

2. In the System Properties dialog box, click the Advanced tab.

3. Click Settings in the Performance area.

4. In the displayed Performance Options dialog box, click the Advanced tab
and then Change. The Virtual Memory dialog box is displayed.

5. Delete virtual memory.

In the Virtual Memory dialog box, deselect Automatically manage paging
file size for all drives, select the paging file of the disk whose virtual memory
is to be deleted, select No paging file, and click Set.

CA UTION

If the warning "If you disable the paging file or set the initial size to less than
xxx megabytes and a system error occurs, Windows might not record details
that could help identify the problem. Do you want to continue?" is displayed,
set the initial size to xxx shown in the warning. The partition for storing
paging files must have sufficient space. If the disk resources are insufficient,
virtual memory will be insufficient. You only need to set virtual memory in
one partition of the ECS.

6. Choose Start > Control Panel > Appearance and Personalization > Show
hidden files and folders. The Folder Options dialog box is displayed. Click
the View tab, deselect Hide protected operating system files
(Recommended), and select Show hidden files, folders, and drives. When
you deselect Hide protected operating system files (Recommended), a
warning is displayed, as shown in Figure 7-18. Click Yes and then click Apply.
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Figure 7-18 Warning

Figure 7-19 Showing hidden files

7. After file hiding is disabled, delete the hidden file pagefile.sys from disk C.
After the OS is restarted, the available space increases.

Disable Hibernation

An ECS running Windows Server 2008 R2 Standard 64-bit is used as an example to
describe how to disable hibernation.

Method 1: Delete the Hiberfil.sys file.

The Hiberfil.sys file is generated by Windows hibernation and occupies large
system disk space. It saves memory data and sessions to disks so that the memory
image file required by sessions can be quickly restored after the computer is
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restarted. Perform the following steps to delete the Hiberfil.sys file to free up
some disk space:

1. Run cmd.exe as an administrator to open the command line interface (CLI).
2. Run the following command to disable hibernation (Hiberfil.sys file will be

automatically deleted):
powercfg -h off

Method 2: Disable hibernation.

1. Choose Start > Control Panel > Appearance and Personalization >
Personalization > Change screen saver and click Change plan settings.

2. In the Power Options window, click Change plan settings on the right of
Balanced (recommended).

3. Set Turn off the display to Never.

Delete Internet Explorer Temporary Files

An ECS running Windows Server 2008 R2 Standard 64bit is used as an example to
describe how to delete temporary files generated by Internet Explorer.

Internet Explorer stores all information about Internet access in a specified folder,
including Internet Explorer cache files, cookies files, browsing history, visited
websites, URLs in the address bar, and Internet Explorer forms/passwords. Perform
the following steps to delete temporary files generated by Internet Explorer:

1. Choose Start > Control Panel > Network and Internet > Internet Options.
Click Delete browsing history and cookies to delete cookies and temporary
files of Internet Explorer.
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2. After the preceding step is performed, there may be residual files or records
left. Open the C:\Windows\temp and C:\Users\Username\AppData\Local
\Temp folders and delete all files in them. (The folders store visited websites
and other temporary information.)

Disable Data Execution Prevention (DEP)

DEP reserves a part of ECS memory for temporarily storing application data and
another part of memory for temporarily storing application instructions. This
protects ECSs from viruses and other security threats.

An ECS running Windows Server 2008 R2 Standard 64-bit is used as an example to
describe how to disable DEP.

1. Right-click the Computer icon and choose Properties. In the displayed
window, click Advanced System Settings.

2. In the System Properties dialog box, click the Advanced tab.
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3. Click Settings in the Performance area.
4. In the Performance Options dialog box, click the Data Execution Prevention

tab, select Turn on DEP for essential Windows programs and services only,
and click Apply.

Delete Redundant Application Files
The C:\Windows\prefetch folder stores the index files generated by applications.
The files are used to improve system performance and speed up system startup
and file reading. However, the number of files increases with time. Deleting
redundant files can free up disk space on Windows.

Delete all files in the C:\Windows\prefetch folder to delete redundant application
files.

Clean Up Disks
You can use Disk Cleanup of ECSs to delete temporary files, empty the recycle
bin, and delete redundant system files and other files.
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On the ECS, click Start. In the search box, enter Disk Cleanup. Click the displayed
Disk Cleanup to scan for the space that can be freed up. After the scan is
complete, confirm the files to be deleted and click OK to start disk cleanup.

If Disk Cleanup is unavailable, you need to install Desktop Experience first. An
ECS running Windows Server 2008 R2 Standard 64bit is used as an example to
describe how to install Desktop Experience.

1. Choose Start > All Programs > Administrative Tools > Server Manager. In
the navigation pane, click Features.

2. Click Add Features.
3. In the Select Features dialog box, select Desktop Experience and click Next.

Figure 7-20 Installing Desktop Experience

4. In the Confirm Installation Selections dialog box, confirm the installation of
Desktop Experience, and click Install.

5. When the installation progress reaches 100% in the Results dialog box, the
system prompts you to restart the server. Click Close, and then click Yes to
restart the server.

6. After the server is restarted, start the server manager. In the Function
Summary area, check whether Desktop Experience is installed.
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Figure 7-21 Successful installation of Desktop Experience

7. Choose Start > All Programs > Accessories > System Tools > Disk Cleanup
to start the disk cleanup tool.

Defragment and Optimize Drives
Disk defragmentation is a process in which system software or professional disk
defragmentation software is used to organize the fragments generated during the
long-term use of disks into the smallest number of contiguous fragments,
improving the performance and running speed of the server.

An ECS running Windows Server 2012 R2 Datacenter 64bit is used as an example
to describe how to defragment and optimize drives.

1. Choose Control Panel > All Control Panel Items > Administrative Tools,
and double-click Defragment and Optimize Drives.

2. Select the disk partition to be optimized, and then click Analyze to analyze
whether the disk partition needs to be optimized. If the analysis result
indicates that optimization is necessary, click Optimize.
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Delete .dmp Files

When a blue screen of death (BSOD) occurs on a Windows ECS, the system
automatically generates a BSOD error file with the suffix .dmp. A .dmp file is a
system error file in Windows, such as, memory.dmp and minixxxx.dmp.

You can manually delete .dmp files from disk C to free up system disk space.

CA UTION

After the .dmp file is deleted, the BSOD cause on the ECS cannot be queried.

Clean Up Component Store

Windows Component Store stores all the files required for installing Windows.
Updated installation files are also stored in Component Store, which causes the
size of Component Store to increase as the update increases.

An ECS running Windows Server 2012 R2 Datacenter 64-bit is used as an example
to describe how to clean up Component Store.

1. In Windows PowerShell, run the following command to delete the backup
files generated during the Service Pack installation:

dism /online /cleanup-image /spsuperseded
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2. Run the following command to check the size of Component Store:
Dism.exe /Online /Cleanup-Image /AnalyzeComponentStore

3. Run the following command to clean up Component Store:
Dism.exe /online /Cleanup-Image /StartComponentCleanup

Delete System Logs
System logs record hardware and software information, system problems, and
system events. You can use the logs to locate error causes or track attacker
actions. System logs include application logs, security logs, startup logs, and event
forwarding logs. The System32 > LogFiles folder on disk C of Windows stores the
operation logs and event logs of Windows. Deleting the folder can free up the
space of disk C.

An ECS running Windows Server 2008 R2 Standard 64-bit is used as an example to
describe how to delete system logs.

1. Open the C:\Windows\System32\LogFiles folder, and delete all the files and
folders in it.
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1. Choose Start, right-click Computer, and choose Manage in the shortcut
menu.

2. In the displayed window, choose Diagnostics > Event Viewer > Windows
Logs and delete logs of Application, Security, Setup, System, and
Forwarded Events.

7.10 How Do I Make a System Disk Image Support Fast
ECS Creation?

Scenarios
Fast Create greatly reduces the time required for creating ECSs from a system disk
image. Currently, this feature is supported by all newly created system disk images
by default. Some existing system disk images may not support this feature, you
can make them support it through image replication.

For example, if image A does not support fast ECS creation, you can replicate it to
generate image copy_A that supports fast ECS creation.

Constraints
Full-ECS images and ISO images cannot be configured using this method.

Check Whether an Image Supports Fast ECS Creation
1. Access the IMS console.

a. Log in to the management console.
b. Under Compute, click Image Management Service.

The IMS console is displayed.
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2. Click the Private Images tab to display the image list.
3. Click the name of the target image.
4. On the displayed image details page, check the value of Fast ECS Creation.

Figure 7-22 Image details

Configure an Image to Make It Support Fast ECS Creation
1. Locate the target system disk image, click More in the Operation column,

and select Replicate from the drop-down list.
The Replicate Image dialog box is displayed.

2. Set Replication Mode to Within Region and set other parameters based on
Replicating Images Within a Region.

3. After the image is successfully replicated, the generated image can be used to
quickly create ECSs.

7.11 What Is the Cause of the Failure to Install a Guest
OS Driver on a Windows ECS?

Possible causes:

● Your image file was exported from a VMware VM, and VMware Tools was not
uninstalled or not completely uninstalled.

● You have downloaded the Guest OS driver of an incorrect version for your
Windows ECS.

● The disk space available for installing the Guest OS driver is insufficient.
Ensure that the disk where the Guest OS driver is installed has at least 300
MB space available.

7.12 How Do I Install the Native Xen and KVM Drivers?

Scenarios
When optimizing a Linux private image with Xen virtualization, you need to install
native Xen and KVM drivers on the source ECS of the image.
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This section describes how to install the native Xen and KVM drivers.

CA UTION

Xen: If you do not install the Xen driver for the image, the network performance of
the ECSs created from this image will be poor, and the security groups and firewall
configured for the ECSs will not take effect.
KVM: If you do not install the KVM driver for the image, the NICs of the ECSs may
not be detected and the ECSs will be unable to communicate with other resources.

Prerequisites
● The virtualization type of the ECS is Xen. For details, see .
● The kernel version must be later than 2.6.24.
● Disable your antivirus and intrusion detection software. You can enable them

after installation of the Xen and KVM drivers.

Procedure

Modify the configuration file depending on the OS.
● CentOS, EulerOS

Take CentOS 7.0 as an example. Modify the /etc/dracut.conf file. Add the
xen-pv and VirtIO drivers to add_drivers. xen-pv drivers include xen-blkfront
and xen-netfront. VirtIO drivers include virtio_blk, virtio_scsi, virtio_net,
virtio_pci, virtio_ring, and virtio. Separate driver names with spaces. Save and
exit the /etc/dracut.conf file. Run the dracut -f command to regenerate
initrd.
For details, see CentOS and EulerOS.

● Ubuntu and Debian
Modify the /etc/initramfs-tools/modules file. Add the xen-pv and VirtIO
drivers. xen-pv drivers include xen-blkfront and xen-netfront. VirtIO drivers
include virtio_blk, virtio_scsi, virtio_net, virtio_pci, virtio_ring, and virtio.
Separate driver names with spaces. Save and exit the /etc/initramfs-tools/
modules file. Run the update-initramfs -u command to regenerate initrd.
For details, see Ubuntu and Debian.

● SUSE and openSUSE
– If the OS version is earlier than SUSE 12 SP1 or openSUSE 13, modify

the /etc/sysconfig/kernel file and add xen-pv and VirtIO drivers to
INITRD_MODULES="". xen-pv drivers include xen_vnif, xen_vbd, and
xen_platform_pci. VirtIO drivers include virtio_blk, virtio_scsi, virtio_net,
virtio_pci, virtio_ring, and virtio. Separate driver names with spaces. Run
the mkinitrd command to regenerate initrd.

– If the OS version is SUSE 12 SP1, modify the /etc/dracut.conf file and
add xen-pv and VirtIO drivers to add_drivers. xen-pv drivers include
xen_vnif, xen_vbd, and xen_platform_pci. VirtIO drivers include virtio_blk,
virtio_scsi, virtio_net, virtio_pci, virtio_ring, and virtio. Separate driver
names with spaces. Run the dracut -f command to regenerate initrd.
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– If the OS version is later than SUSE 12 SP1 or openSUSE 13, modify
the /etc/dracut.conf file and add xen-pv and VirtIO drivers to
add_drivers. xen-pv drivers include xen-blkfront and xen-netfront. VirtIO
drivers include virtio_blk, virtio_scsi, virtio_net, virtio_pci, virtio_ring, and
virtio. Separate driver names with spaces. Save and exit the /etc/
dracut.conf file. Run the dracut -f command to regenerate initrd.

For details, see SUSE and openSUSE.

NO TE

For SUSE, run the following command to check whether xen-kmp (driver package for
xen-pv) is installed:
rpm -qa |grep xen-kmp
If information similar to the following is displayed, xen-kmp is installed in the OS:
xen-kmp-default-4.2.2_04_3.0.76_0.11-0.7.5

If xen-kmp is not installed, obtain it from the ISO file and install it.
If you add built-in drivers to the initrd or initramfs file by mistake, the ECS will not be
affected.

CentOS and EulerOS
1. Run the following command to open the /etc/dracut.conf file:

vi /etc/dracut.conf
2. Press i to enter editing mode and add the xen-pv and VirtIO drivers to

add_drivers (the format varies depending on the OS).
[root@CTU10000xxxxx ~]# vi /etc/dracut.conf 
# additional kernel modules to the default 
add_drivers+="xen-blkfront xen-netfront virtio_blk virtio_scsi virtio_net virtio_pci virtio_ring 
virtio" 
......

3. Press Esc, enter :wq, and press Enter. The system saves the change and exits
the /etc/dracut.conf file.

4. Run the following command to regenerate initrd:
dracut -f /boot/initramfs-2.6.32-573.8.1.el6.x86_64.img
If the virtual file system is not the default initramfs, run the dracut -f Name
of the initramfs or initrd file actually used command. The actual initramfs or
initrd file name can be obtained from the grub.cfg file, which can be /boot/
grub/grub.cfg, /boot/grub2/grub.cfg, or /boot/grub/grub.conf depending
on the OS.

5. If the virtual file system is initramfs, run the following commands to check
whether native Xen and KVM drivers have been loaded:
lsinitrd /boot/initramfs-`uname -r`.img | grep xen
lsinitrd /boot/initramfs-`uname -r`.img | grep virtio
If the virtual file system is initrd, run the following commands to check
whether native Xen and KVM drivers have been loaded:
lsinitrd /boot/initrd-`uname -r` | grep xen
lsinitrd /boot/initrd-`uname -r` | grep virtio
Assume that the virtual file system is initramfs. The following command
output will be displayed:
[root@CTU10000xxxxx home]# lsinitrd /boot/initramfs-`uname -r`.img | grep xen 
-rwxr--r--   1 root     root        54888 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/drivers/
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block/xen-blkfront.ko 
-rwxr--r--   1 root     root        45664 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/
drivers/net/xen-netfront.ko 
 
[root@CTU10000xxxxx home]# lsinitrd /boot/initramfs-`uname -r`.img | grep virtio 
-rwxr--r--   1 root     root        23448 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/drivers/
block/virtio_blk.ko 
-rwxr--r--   1 root     root        50704 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/
drivers/net/virtio_net.ko 
-rwxr--r--   1 root     root        28424 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/drivers/
scsi/virtio_scsi.ko 
drwxr-xr-x   2 root     root            0 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/drivers/
virtio 
-rwxr--r--   1 root     root        14544 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/drivers/
virtio/virtio.ko 
-rwxr--r--   1 root     root        21040 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/drivers/
virtio/virtio_pci.ko 
-rwxr--r--   1 root     root        18016 Jul 16 17:53 lib/modules/2.6.32-573.8.1.el6.x86_64/kernel/drivers/
virtio/virtio_ring.ko

NO TE

If you add built-in drivers to the initrd or initramfs file, the ECS will not be affected.
This makes it easy to modify the drivers. However, you cannot check the drivers by
running the lsinitrd command. You can run the following commands to check whether
built-in drivers are in the kernel:
cat /boot/config-`uname -r` | grep CONFIG_VIRTIO | grep y
cat /boot/config-`uname -r` | grep CONFIG_XEN | grep y

Ubuntu and Debian
1. Run the following command to open the modules file:

vi /etc/initramfs-tools/modules
2. Press i to enter editing mode and add the xen-pv and VirtIO drivers to

the /etc/initramfs-tools/modules file (the format varies depending on the
OS).
[root@CTU10000xxxxx ~]#vi /etc/initramfs-tools/modules 
......
# Examples: 
# 
# raid1 
# sd_mOd 
xen-blkfront
xen-netfront
virtio_blk
virtio_scsi
virtio_net
virtio_pci
virtio_ring
virtio

3. Press Esc, enter :wq, and press Enter. The system saves the change and exits
the /etc/initramfs-tools/modules file.

4. Run the following command to regenerate initrd:
update-initramfs -u

5. Run the following commands to check whether native Xen and KVM drivers
have been installed:
lsinitramfs /boot/initrd.img-`uname -r` |grep xen
lsinitramfs /boot/initrd.img-`uname -r` |grep virtio
[root@ CTU10000xxxxx home]# lsinitramfs /boot/initrd.img-`uname -r` |grep xen 
lib/modules/3.5.0-23-generic/kernel/drivers/net/ethernet/qlogic/netxen 
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lib/modules/3.5.0-23-generic/kernel/drivers/net/ethernet/qlogic/netxen/netxen_nic.ko 
lib/modules/3.5.0-23-generic/kernel/drivers/net/xen-netback 
lib/modules/3.5.0-23-generic/kernel/drivers/net/xen-netback/xen-netback.ko 
lib/modules/3.5.0-23-generic/kernel/drivers/block/xen-blkback 
lib/modules/3.5.0-23-generic/kernel/drivers/block/xen-blkback/xen-blkback.ko 
 
[root@ CTU10000xxxxx home]# lsinitramfs /boot/initrd.img-`uname -r` |grep virtio 
lib/modules/3.5.0-23-generic/kernel/drivers/scsi/virtio_scsi.ko

NO TE

If you add built-in drivers to the initrd or initramfs file, the ECS will not be affected.
This makes it easy to modify the drivers. However, you cannot check the drivers by
running the lsinitrd command. You can run the following commands to check whether
built-in drivers are in the kernel:
[root@ CTU10000xxxxx home]# cat /boot/config-`uname -r` | grep CONFIG_VIRTIO | grep y
CONFIG_VIRTIO_BLK=y
CONFIG_VIRTIO_NET=y
CONFIG_VIRTIO=y
CONFIG_VIRTIO_RING=y
CONFIG_VIRTIO_PCI=y
CONFIG_VIRTIO_MMIO_CMDLINE_DEVICES=y
[root@ CTU10000xxxxx home]# cat /boot/config-`uname -r` | grep CONFIG_XEN | grep y
CONFIG_XEN_BLKDEV_FRONTEND=y
CONFIG_XEN_NETDEV_FRONTEND=y

SUSE and openSUSE

If the OS version is earlier than SUSE 12 SP1 or openSUSE 13, modify the /etc/
sysconfig/kernel file. For details, see scenario 1.

If the OS version is SUSE 12 SP1, modify the /etc/dracut.conf file and add xen-pv
and VirtIO drivers. For details, see scenario 2.

If the OS version is later than SUSE 12 SP1 or openSUSE 13, modify the /etc/
dracut.conf file and add xen-pv and VirtIO drivers to add_drivers. For details, see
scenario 3.
● If the OS version is earlier than SUSE 12 SP1 or openSUSE 13, perform the

following steps:

NO TE

For SUSE, run the following command to check whether xen-kmp (driver package for
xen-pv) is installed in the OS:

rpm -qa |grep xen-kmp

If information similar to the following is displayed, xen-kmp is installed:
xen-kmp-default-4.2.2_04_3.0.76_0.11-0.7.5

If xen-kmp is not installed, obtain it from the installation ISO and install it first.

a. Run the following command to open the /etc/sysconfig/kernel file:
vi /etc/sysconfig/kernel

b. Add the xen-pv and VirtIO drivers after INITRD_MODULES= (the format
of drivers depends on the OS).
SIA10000xxxxx:~ # vi /etc/sysconfig/kernel 
# (like drivers for scsi-controllers, for lvm or reiserfs)
#
INITRD_MODULES="ata_piix ata_generic xen_vnif xen_vbd xen_platform_pci virtio_blk 
virtio_scsi virtio_net virtio_pci virtio_ring virtio"

c. Run the mkinitrd command to regenerate initrd:
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NO TE

If the virtual file system is not the default initramfs or initrd, run the dracut -f
Name of the initramfs or initrd file actually used command. The actual initramfs
or initrd file name can be obtained from the menu.lst or grub.cfg file (/boot/
grub/menu.lst, /boot/grub/grub.cfg, or /boot/grub2/grub.cfg).

The following is an example initrd file of SUSE 11 SP4:
default 0
timeout 10
gfxmenu (hd0,0)/boot/message
title sles11sp4_001_[_VMX_]
root (hd0,0)
kernel /boot/linux.vmx vga=0x314 splash=silent console=ttyS0,115200n8 console=tty0 
net.ifnames=0 NON_PERSISTENT_DEVICE_NAMES=1 showopts
initrd /boot/initrd.vmx
title Failsafe_sles11sp4_001_[_VMX_]
root (hd0,0)
kernel /boot/linux.vmx vga=0x314 splash=silent ide=nodma apm=off noresume edd=off 
powersaved=off nohz=off highres=off processsor.max+cstate=1 nomodeset x11failsafe 
console=ttyS0,115200n8 console=tty0 net.ifnames=0 NON_PERSISTENT_DEVICE_NAMES=1 
showopts
initrd /boot/initrd.vmx

/boot/initrd.vmx in the initrd line is the initrd file actually used. Run the
dracut -f /boot/initrd.vmx command. If the initrd file does not contain
the /boot directory, such as /initramfs-xxx, run the dracut -f /boot/
initramfs-xxx command.

d. Run the following commands to check whether the PVOPS module for
Xen or VirtIO module for KVM is loaded:
lsinitrd /boot/initrd-`uname -r` | grep xen
lsinitrd /boot/initrd-`uname -r` | grep virtio
SIA10000xxxxx:~ # lsinitrd /boot/initrd-`uname -r` | grep xen
-rwxr--r-- 1 root root 42400 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/block/
xen-blkfront.ko
-rwxr--r-- 1 root root 44200 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/net/
xen-netfront.ko

SIA10000xxxxx:~ # lsinitrd /boot/initrd-`uname -r` | grep virtio
-rwxr--r-- 1 root root 19248 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/scsi/
virtio_scsi.ko
-rwxr--r-- 1 root root 23856 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/block/
virtio_blk.ko
drwxr-xr-x 2 root root 0 Jul 12 14:53 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/virtio
-rwxr--r-- 1 root root 15848 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/virtio/
virtio_ring.ko
-rwxr--r-- 1 root root 20008 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/virtio/
virtio_pci.ko
-rwxr--r-- 1 root root 12272 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/virtio/
virtio.ko
-rwxr--r-- 1 root root 38208 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/net/
virtio_net.ko

e. Restart the ECS.
f. Modify the /boot/grub/menu.lst file. Add

xen_platform_pci.dev_unplug=all and modify the root configuration.
Before the modification:
###Don't change this comment -YaST2 identifier: Original name: linux###
title SUSE Linux Enterprise Server 11SP4 - 3.0.76-0.11 (default) 
root (hd0,0) 
kernel /boot/vmlinuz-3.0.76-0.11-default root=UUID=4eb40294-4c6f-4384-bbb6-
b8795bbb1130 splash=silentcrashkernel=256M-:128M showopts vga=0x314
initrd /boot/initrd-3.0.76-0.11-default
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After the modification:
###Don't change this comment -YaST2 identifier: Original name: linux###
title SUSE Linux Enterprise Server 11SP4 - 3.0.76-0.11 (default) 
root (hd0,0) 
kernel /boot/vmlinuz-3.0.76-0.11-default root=UUID=4eb40294-4c6f-4384-bbb6-
b8795bbb1130 splash=silentcrashkernel=256M-:128M showopts vga=0x314 
xen_platform_pci.dev_unplug=all 
initrd /boot/initrd-3.0.76-0.11-default

NO TE

● Ensure that the root partition is in the UUID format.

● xen_platform_pci.dev_unplug=all is added to shield QEMU devices.

● For SUSE 11 SP1 64bit to SUSE 11 SP4 64bit, add
xen_platform_pci.dev_unplug=all to the menu.lst file. For SUSE 12 or later,
this function is enabled by default, and you do not need to configure it.

g. Run the following commands to check whether the Xen drivers exist in
initrd:

lsinitrd /boot/initrd-`uname -r` | grep xen

lsinitrd /boot/initrd-`uname -r` | grep virtio
SIA10000xxxxx:~ # lsinitrd /boot/initrd-`uname -r` | grep xen
-rwxr--r-- 1 root root 42400 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/block/
xen-blkfront.ko
-rwxr--r-- 1 root root 44200 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/net/
xen-netfront.ko

SIA10000xxxxx:~ # lsinitrd /boot/initrd-`uname -r` | grep virtio
-rwxr--r-- 1 root root 19248 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/scsi/
virtio_scsi.ko
-rwxr--r-- 1 root root 23856 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/block/
virtio_blk.ko
drwxr-xr-x 2 root root 0 Jul 12 14:53 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/virtio
-rwxr--r-- 1 root root 15848 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/virtio/
virtio_ring.ko
-rwxr--r-- 1 root root 20008 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/virtio/
virtio_pci.ko
-rwxr--r-- 1 root root 12272 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/virtio/
virtio.ko
-rwxr--r-- 1 root root 38208 Jun 22 2012 lib/modules/2.6.32-279.el6.x86_64/kernel/drivers/net/
virtio_net.ko

NO TE

If you add built-in drivers to the initrd or initramfs file, the ECS will not be
affected. This makes it easy to modify the drivers. However, you cannot check the
drivers by running the lsinitrd command. You can run the following commands
to check whether built-in drivers are in the kernel:

cat /boot/config-`uname -r` | grep CONFIG_VIRTIO | grep y

cat /boot/config-`uname -r` | grep CONFIG_XEN | grep y

● If the OS version is SUSE 12 SP1, perform the following steps:

a. Run the following command to open the /etc/dracut.conf file:

vi /etc/dracut.conf

b. Press i to enter editing mode and add the xen-pv and VirtIO drivers to
add-drivers (the format varies depending on the OS).
[root@CTU10000xxxxx ~]# vi /etc/dracut.conf 
# additional kernel modules to the default
add_drivers+="ata_piix ata_generic xen_vnif xen_vbd xen_platform_pci virtio_blk virtio_scsi 
virtio_net virtio_pci virtio_ring virtio"
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c. Press Esc, enter :wq, and press Enter. The system saves the change and
exits the /etc/dracut.conf file.

d. Run the following command to regenerate initrd:
dracut -f /boot/initramfs-File name
If the virtual file system is not the default initramfs, run the dracut -f
Name of the initramfs or initrd file actually used command. The actual
initramfs or initrd file name can be obtained from the grub.cfg file, which
can be /boot/grub/grub.cfg, /boot/grub2/grub.cfg, or /boot/grub/
grub.conf depending on the OS.

e. If the virtual file system is initramfs, run the following commands to
check whether native Xen and KVM drivers have been loaded:
lsinitrd /boot/initramfs-`uname -r`.img | grep xen
lsinitrd /boot/initramfs-`uname -r`.img | grep virtio
If the virtual file system is initrd, run the following commands to check
whether native Xen and KVM drivers have been loaded:
lsinitrd /boot/initrd-`uname -r` | grep xen
lsinitrd /boot/initrd-`uname -r` | grep virtio

● If the OS version is later than SUSE 12 SP1 or openSUSE 13, perform the
following steps:
Take SUSE Linux Enterprise Server 12 SP2 (x86_64) as an example.

a. Run the following command to open the /etc/dracut.conf file:
vi /etc/dracut.conf

b. Press i to enter editing mode and add the xen-pv and VirtIO drivers to
add_drivers (the format varies depending on the OS).
[root@CTU10000xxxxx ~]# vi /etc/dracut.conf 
# additional kernel modules to the default
add_drivers+="ata_piix ata_generic xen-blkfront xen-netfront virtio_blk virtio_scsi 
virtio_net virtio_pci virtio_ring virtio"

c. Press Esc, enter :wq, and press Enter. The system saves the change and
exits the /etc/dracut.conf file.

d. Run the following command to regenerate initrd:
dracut -f /boot/initramfs-File name
If the virtual file system is not the default initramfs, run the dracut -f
Name of the initramfs or initrd file actually used command. The actual
initramfs or initrd file name can be obtained from the grub.cfg file, which
can be /boot/grub/grub.cfg, /boot/grub2/grub.cfg, or /boot/grub/
grub.conf depending on the OS.

e. If the virtual file system is initramfs, run the following commands to
check whether native Xen and KVM drivers have been loaded:
lsinitrd /boot/initramfs-`uname -r`.img | grep xen
lsinitrd /boot/initramfs-`uname -r`.img | grep virtio
If the virtual file system is initrd, run the following commands to check
whether the native Xen and KVM driver modules are successfully loaded:
lsinitrd /boot/initrd-`uname -r` | grep xen
lsinitrd /boot/initrd-`uname -r` | grep virtio
Assume that the virtual file system is initrd. The following command
output will be displayed:
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sluo-ecs-30dc:~ # lsinitrd /boot/initrd-`uname -r` | grep xen
-rw-r--r-- 1 root root 69575 Oct 26 2016 lib/modules/4.4.21-69-default/kernel/drivers/block/xen-
blkfront.ko
-rw-r--r-- 1 root root 53415 Oct 26 2016 lib/modules/4.4.21-69-default/kernel/drivers/net/xen-
netfront.ko
drwxr-xr-x 2 root root 0 Sep 28 10:21 lib/modules/4.4.21-69-default/updates/pvdriver/xen-hcall
-rwxr-xr-x 1 root root 8320 Sep 28 10:21 lib/modules/4.4.21-69-default/updates/pvdriver/xen-
hcall/xen-hcall.ko

sluo-ecs-30dc:~ # lsinitrd /boot/initrd-`uname -r` | grep virtio
-rw-r--r-- 1 root root 29335 Oct 26 2016 lib/modules/4.4.21-69-default/kernel/drivers/block/
virtio_blk.ko
-rw-r--r-- 1 root root 57007 Oct 26 2016 lib/modules/4.4.21-69-default/kernel/drivers/net/
virtio_net.ko
-rw-r--r-- 1 root root 32415 Oct 26 2016 lib/modules/4.4.21-69-default/kernel/drivers/scsi/
virtio_scsi.ko
drwxr-xr-x 2 root root 0 Sep 28 10:21 lib/modules/4.4.21-69-default/kernel/drivers/virtio
-rw-r--r-- 1 root root 19623 Oct 26 2016 lib/modules/4.4.21-69-default/kernel/drivers/virtio/
virtio.ko
-rw-r--r-- 1 root root 38943 Oct 26 2016 lib/modules/4.4.21-69-default/kernel/drivers/virtio/
virtio_pci.ko
-rw-r--r-- 1 root root 24431 Oct 26 2016 lib/modules/4.4.21-69-default/kernel/drivers/virtio/
virtio_ring.ko

NO TE

If you add built-in drivers to the initrd or initramfs file, the ECS will not be
affected. This makes it easy to modify the drivers. However, you cannot check the
drivers by running the lsinitrd command. You can run the following commands
to check whether built-in drivers are in the kernel:
cat /boot/config-`uname -r` | grep CONFIG_VIRTIO | grep y
cat /boot/config-`uname -r` | grep CONFIG_XEN | grep y
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8 Image Replication

When Do I Need to Replicate an Image?

Image replication includes in-region replication and cross-region replication.

● In-region replication

This is used for conversion between encrypted and unencrypted images or for
enabling advanced features (such as fast ECS creation) for images. For details,
see Replicating Images Within a Region.

● Cross-region replication

This is used for replicating a private image in the current region to the same
account in another region. You can use this private image to deploy the same
application environment in the two regions. For details, see Replicating
Images Across Regions.

What Images Can I Replicate?

Only private images can be replicated. The restrictions on image replication are as
follows:

● In-region replication

Private images created from ISO files and full-ECS images do not support in-
region replication.

● Cross-region replication

Encrypted images do not support cross-region replication.

Can I Replicate Images Across Regions Between the Chinese Mainland,
International, and European Websites?

The Chinese Mainland, International, and European websites are accessed by using
different accounts. You cannot replicate images between these websites through
cross-region replication. However, you can do the replication in the following way:

For example, if you want to replicate a system disk image from the CN-Hong
Kong region of the International website to the CN East-Shanghai1 region of the
Chinese Mainland website, perform the following operations:
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1. Log in to the console of the International website, export the image from the
CN-Hong Kong region to an OBS bucket in the region, and download the
image to a local directory. Assume that the image file is exported as
Windows Server 2012.qcow2.
For details, see Exporting an Image.

2. Log in to the console of the Chinese Mainland website, switch to the CN East-
Shanghai1 region, and upload the Windows Server 2012.qcow2 image file to
an OBS bucket in the region.
For details, see Uploading an External Image File.

3. Register the image file as a private image
For details, see Registering an External Image File as a Private Image.

How Long Does It Take to Replicate an Image?
The time required for replicating an image depends on the network transmission
speed and the number of tasks in the queue.

What Is the Charge for Image Replication?
● In-region replication

The replicas of system disk and data disk images are stored in OBS buckets
for free.

NO TE

Full-ECS images cannot be replicated within the same region.

● Cross-region replication
System disk and data disk images: You are charged for the OBS traffic for
replicating images cross regions.
Full-ECS images: You are charged for the CSBS or CBR traffic for replicating
images cross regions and also charged for the space used to store the CSBS or
CBR backups associated with the replicas.

NO TE

The process of cross-region full-ECS image replication is as follows:
1. The system replicates the backup of a full-ECS image to the destination region.
2. In the destination region, the system automatically generates a full-ECS image

from the backup.

Is There a Limit on the Image Size During Cross-Region Replication?
Yes. An image to be replicated cannot be larger than 128 GB.

If your image file exceeds 128 GB and you want to replicate it between regions,
you are advised to export the image to an OBS bucket, import the image to an
OBS bucket in the destination region, and register it as a private image.

What Is the Maximum Number of Concurrent Cross-Region Image
Replication Tasks?

Five.
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How Do I Replicate an Image Between Projects in a Region?
Cross-region image replication allows you to replicate images between regions.
Image sharing allows you to replicate images between projects in the same
region.

In the Share Image dialog box, enter target project IDs, and click OK, as
instructed in Sharing Specified Images. After the image is shared, switch to the
target projects. On the Image Management Service > Images Shared with Me
page, you can view the shared image to be accepted.

Figure 8-1 Accepting or rejecting shared images

What Are the Regions That Support Cross-Region Replication of System and
Data Disk Images?

Figure 8-2 Regions that support cross-region replication of system and data disk
images
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NO TE

● √ indicates that cross-region replication of system and data disk images is supported.
● × indicates that cross-region replication of system and data disk images is not

supported. In this case, export the desired image and then import it to the target region.
● - indicates that the source and destination regions are the same.
● Region adjustment may affect cross-region image replication of users that are registered

after the adjustment. In this case, whether the replication can be performed is subject to
the management console display. The users that were registered before the adjustment
are not affected.

● Regions not listed in Figure 8-2 do not support cross-region replication of system and
data disk images.

What Are the Regions That Support Cross-Region Full-ECS Image
Replication?

Cross-region replication of full-ECS images is also available in certain regions.

If a full-ECS image cannot be replicated to a different region, you can use it to
create an ECS, use the ECS to create a system disk image and a data disk image,
and replicate the images to the destination region.
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9 Image Deletion

Will a Private Image Be Automatically Deleted If I Delete or Unsubscribe
from the ECS Used to Create the Image?

No. Private images created using ECSs are stored in OBS buckets. Deleting or
unsubscribing from the ECS used to create a private image does not affect the
image.

Can I Delete an Image I Shared with Others If My Image Quota Becomes
Insufficient?

Yes. You can delete a shared image without requiring any operation by image
recipients. After you delete the image, the image recipients cannot use it any
longer. Inform the image recipients to back up their data before you delete the
image.

How Do I Delete a Shared Image? Does the Deletion Affect an ECS or EVS
Disk Created from It?

Reject this image on the Images Shared with Me tab page. This does not affect
an ECS or EVS disk created from it.
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10 Image Encryption

How Can I Change an Unencrypted Image to an Encrypted One?
If you want to store an unencrypted image in an encrypted way, you can select an
encryption key when you replicate the image. Then, the system will generate an
encrypted replica of the unencrypted image.

Constraints
● An encrypted image cannot be shared with other tenants.
● The key used for encrypting an image cannot be changed.
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11 Accounts and Permissions

11.1 What Do I Do If Private Images Cannot Be Found
on the Enterprise Project Management Service Page
After EPS Is Enabled?

Scenarios

If you cannot find the private images on the Enterprise Project Management
Service page, add the private images to their associated enterprise project.

Procedure
1. Log in to the management console.

2. Under Compute, click Image Management Service.

3. Click the Private Images tab.

4. Locate the row that contains the image, click More in the Operation column,
and select Allocate to Enterprise Project.

5. In the displayed dialog box, select the target enterprise project.

11.2 What Do I Do If I Cannot Create an Image from a
CSBS Backup or BMS Using a Subaccount with the
Allow_all Permission After EPS Is Enabled?

When an enterprise project subaccount is used to create an image, the system
displays a message indicating that CSBS or BMS is not supported by EPS. This is
because CSBS and BMS are not interconnected with EPS regionally or globally. The
global resource viewing permission must be granted to the subaccount in IAM. For
example, you can view resources of other cloud services if you have the Tenant
Guest permission.
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12 Cloud-Init

12.1 Cloud-Init
You are advised to install Cloud-Init on the ECS that will be used to create a
private image so that new ECSs created from the private image support custom
configurations (for example, changing the ECS login password).

For details about how to install Cloud-Init, see Installing Cloud-Init.

For details about how to configure Cloud-Init, see Configuring Cloud-Init.

The following describes common problems you may encounter when installing
Cloud-Init and their solutions.

Ubuntu 16.04/CentOS 7: Failed to Set Cloud-Init Automatic Start
● Symptom:

After Cloud-Init is installed, run the following command to set Cloud-Init
automatic start:
systemctl enable cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service
Information similar to the following is displayed:

Figure 12-1 Failed to enable Cloud-Init to start automatically

● Solution:

a. Run the following command to roll back the configuration:
systemctl unmask cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service

b. Run the following command to set automatic start again:
systemctl enable cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service
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c. Run the following command to check the Cloud-Init status:
systemctl status cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service
As shown in the following figures, failed is displayed and all services are
in the inactive state.

Figure 12-2 Checking Cloud-Init status

Figure 12-3 Checking Cloud-Init status

This is because the address that the system uses to access Cloud-Init is
redirected to /usr/bin/, but the actual installation path is /usr/local/bin.

d. Run the following command to copy Cloud-Init to the usr/bin directory:
cp /usr/local/cloud-init /usr/bin/

e. Run the following command to restart Cloud-Init:
systemctl restart cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service

Figure 12-4 Restarting Cloud-Init

f. Run the following command to check the Cloud-Init status:
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systemctl status cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service

Ubuntu 14.04: chkconfig and systemctl Not Installed
● Symptom:

chkconfig is not installed.
● Solution:

Run the following commands to install chkconfig:
apt-get update
apt-get install sysv-rc-conf
cp /usr/sbin/sysv-rc-conf /usr/sbin/chkconfig
Run the following command to query the Cloud-Init version:
cloud-init -v
Information similar to the following is displayed:
-bash:/usr/bin/cloud-init:not found this command

Solution: Run the following command to copy Cloud-Init to the usr/bin
directory:
cp /usr/local/bin/cloud-init /usr/bin/

Debian 9.5: Failed to Query the Cloud-Init Version and Set Automatic Start
1. Run the following command to query the Cloud-Init version:

cloud-init -v
Information similar to the following is displayed:
-bash:/usr/bin/cloud-init:not found this command

Solution: Run the cp /usr/local/bin/cloud-init /usr/bin/ command to copy
Cloud-Init to the usr/bin directory.

2. Run the cloud-init init --local command.
Information similar to the following is displayed:

Figure 12-5 Information returned when Cloud-Init automatic start
successfully set

Cause analysis: The compilation fails because GCC is not installed.
Solution:
Run the following command to install GCC. Then, install Cloud-Init again.
yum -y install gcc

3. After Cloud-Init is installed, run the following command to set Cloud-Init
automatic start:
systemctl enable cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service
Information similar to the following is displayed.
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Figure 12-6 Prompt indicating the failure to set Cloud-Init automatic start

Solution:

a. Run the following command to roll back the configuration:
systemctl unmask cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service

b. Run the following command to set automatic start again:
systemctl enable cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service

c. Run the following command to restart Cloud-Init:
systemctl restart cloud-init-local.service cloud-init.service cloud-
config.service cloud-final.service
Run the systemctl status command to check the Cloud-Init status.
Information similar to the following is displayed:

Figure 12-7 Verifying the service status

CentOS 7/Fedora 28: Required C Compiler Not Installed
● Symptom

After Cloud-Init is successfully installed, run the following command:
cloud-init init --local
The following information is displayed:
/usr/lib/python2.5/site-packages/Cheetah/Compiler.py:1532: UserWarning: 
You don't have the C version of NameMapper installed! I'm disabling Cheetah's useStackFrames 
option as it is painfully slow with the Python version of NameMapper. You should get a copy of 
Cheetah with the compiled C version of NameMapper.
  "\nYou don't have the C version of NameMapper installed!

● Cause analysis
This alarm is generated because C version of NameMapper needs to be
compiled when Cloud-Init is installed. However, GCC is not installed in the
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system, and the compilation cannot be performed. As a result, NameMapper
is missing.

● Solution
Run the following command to install GCC:
yum -y install gcc
Reinstall Cloud-Init.

CentOS 7/Fedora: Failed to Use the New Password to Log In to an ECS
Created from an Image

● Symptom
After Cloud-Init is successfully installed on an ECS, an image is created from
the ECS. You cannot use a new password to log in to the ECSs created from
this image. When you log in to the ECSs using the old password, you find that
NICs of these ECSs are not started.

Figure 12-8 NIC not started

● Solution:
Log in to the ECS used to create the image, open the DHCP configuration
file /etc/sysconfig/network-scripts/ifcfg-ethX, and comment out HWADDR.

12.2 What Can I Do with a Cloud-Init ECS?

Introduction to Cloud-Init
Cloud-Init is an open-source tool for cloud instance initialization. When creating
ECSs from an image with Cloud-Init, you can use user data injection to inject
customized initialization details (for example, an ECS login password) to the ECSs.
You can also configure and manage a running ECS by querying and using
metadata. If Cloud-Init is not installed, you cannot apply custom configurations to
the ECSs. You will have to use the original password in the image file to log in to
the ECSs.

Installation Methods
You are advised to install Cloud-Init or Cloudbase-Init on the ECS to be used to
create a private image so that new ECSs created from the private image support
custom configurations.

● For Linux OSs, download and install Cloud-Init.
For how to install Cloud-Init, see Installing Cloud-Init.
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For how to configure Cloud-Init, see Configuring Cloud-Init.

12.3 What Do I Do If Injecting the Key or Password
Using Cloud-Init Failed After NetworkManager Is
Installed?

Symptom

A major cause is that the version of Cloud-Init is incompatible with that of
NetworkManager. In Debian 9.0 and later versions, NetworkManager is
incompatible with Cloud-Init 0.7.9.

Solution

Uninstall the current Cloud-Init and install Cloud-Init 0.7.6 or an earlier version.

For details about how to install Cloud-Init, see Installing Cloud-Init.

12.4 How Do I Install growpart for SUSE 11 SP4?

Scenarios

growpart for SUSE and openSUSE is an independent toolkit that does not start
with cloud-*. Perform operations in this section to install growpart.

Procedure
1. Run the following commands to check whether Cloud-Init and growpart have

been installed:
rpm -qa | grep cloud-init
The command output is as follows:
cloud-init-0.7.8-39.2

rpm -qa | grep growpart
The command output is as follows:
growpart-0.29-8.1

2. Run the following command to uninstall Cloud-Init and growpart:
zypper remove cloud-init growpart

3. Run the following commands to delete residual files:
rm -fr /etc/cloud/*
rm -fr /var/lib/cloud/*

4. Run the following command to install growpart:
zypper install http://download.opensuse.org/repositories/home:/garloff:/
OTC:/cloudinit/SLE_11_SP4/noarch/growpart-0.27-1.1.noarch.rpm

5. Run the following command to install python-oauth:

Image Management Service
FAQs 12 Cloud-Init

Issue 02 (2023-08-10) Copyright © Huawei Technologies Co., Ltd. 88

https://support.huaweicloud.com/eu/usermanual-ims/ims_01_0407.html
https://support.huaweicloud.com/eu/usermanual-ims/en-us_topic_0030730603.html


zypper install http://download.opensuse.org/repositories/home:/garloff:/
OTC:/cloudinit/SLE_11_SP4/x86_64/python-oauth-1.0.1-35.1.x86_64.rpm

6. Run the following command to install Cloud-Init:
zypper install http://download.opensuse.org/repositories/home:/garloff:/
OTC:/cloudinit/SLE_11_SP4/x86_64/cloud-init-0.7.6-27.23.1.x86_64.rpm

7. Run the following commands to check whether growpart, python-oauth, and
Cloud-Init have been installed successfully:
rpm -qa | grep growpart
The command output is as follows:
growpart-0.27-1.1

rpm -qa | grep python-oauth
The command output is as follows:
python-oauthlib-0.6.0-1.5
python-oauth-1.0.1-35.1

rpm -qa | grep cloud-init
The command output is as follows:
cloud-init-0.7.6-27.19.1

8. Run the following command to check the configuration:
chkconfig cloud-init-local on;chkconfig cloud-init on;chkconfig cloud-
config on;chkconfig cloud-final on
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13 ECS Creation

13.1 Can I Change the Image of a Purchased ECS?
Yes.

If you have selected an incorrect image or your service requirements have
changed, you can change the image of your ECS.

You can change the image type (public, private, and shared images) and OS. For
details, see Changing the OS.

13.2 Can I Use a Private Image to Create ECSs with
Different Hardware Specifications from the ECS Used
to Create the Private Image?

Yes. You can specify the CPU, memory, bandwidth, data disks of the new ECSs if
necessary. You can also specify their system disk size. The value must be smaller
than 1024 GB but no less than the system disk size in the image.

13.3 Can I Specify the System Disk Size When I Create
an ECS Using an Image?

Yes. However, the value must be smaller than 1024 GB but no less than the
system disk size in the image.
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13.4 What Do I Do If No Partition Is Found During the
Startup of an ECS Created from an Imported Private
Image?

Symptom

This may be caused by a disk partition ID change after the cross-platform image
import. As a result, no partition can be found based on the original disk partition
ID in the image. In this case, you need to change the disk partition in the image
(UUID=UUID of the disk partition).

Solution

The following uses openSUSE 13.2 as an example to describe how to change the
partition name.

1. Run the following command to query the disk partition ID:
ls -l /dev/disk/by-id/
The example command output is as follows.
total 0
lrwxrwxrwx 1 root root 10 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001 -> ../../xvda
lrwxrwxrwx 1 root root 11 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001-part1 -> ../../xvda1
lrwxrwxrwx 1 root root 12 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001-part10 -> ../../xvda10
lrwxrwxrwx 1 root root 11 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001-part2 -> ../../xvda2
lrwxrwxrwx 1 root root 11 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001-part5 -> ../../xvda5
lrwxrwxrwx 1 root root 11 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001-part6 -> ../../xvda6
lrwxrwxrwx 1 root root 11 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001-part7 -> ../../xvda7
lrwxrwxrwx 1 root root 11 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001-part8 -> ../../xvda8
lrwxrwxrwx 1 root root 11 Jul 22 01:35 ata-QEMU_HARDDISK_QM00001-part9 -> ../../xvda9
lrwxrwxrwx 1 root root 10 Jul 22 01:35 ata-QEMU_HARDDISK_QM00005 -> ../../xvde
lrwxrwxrwx 1 root root 10 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001 -> ../../xvda
lrwxrwxrwx 1 root root 11 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001-part1 -> ../../xvda1
lrwxrwxrwx 1 root root 12 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001-part10 -> ../../xvda10
lrwxrwxrwx 1 root root 11 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001-part2 -> ../../xvda2
lrwxrwxrwx 1 root root 11 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001-part5 -> ../../xvda5
lrwxrwxrwx 1 root root 11 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001-part6 -> ../../xvda6
lrwxrwxrwx 1 root root 11 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001-part7 -> ../../xvda7
lrwxrwxrwx 1 root root 11 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001-part8 -> ../../xvda8
lrwxrwxrwx 1 root root 11 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00001-part9 -> ../../xvda9
lrwxrwxrwx 1 root root 10 Jul 22 01:35 scsi-SATA_QEMU_HARDDISK_QM00005 -> ../../xvde

ata-QEMU_HARDDISK_xxx and scsi-SATA_QEMU_HARDDISK_xxx indicate
that the disk of the ECS is simulated using Quick EMUlator (QEMU). The
content on the left of -> is the disk partition ID, and that on the right of -> is
the partition name.

2. Run the following command to query the disk partition UUID:
ls -l /dev/disk/by-uuid/
The example command output is as follows.
total 0
lrwxrwxrwx 1 root root 11 Jul 22 01:35 45ecd7a0-29da-4402-a017-4564a62308b8 -> ../../xvda5
lrwxrwxrwx 1 root root 11 Jul 22 01:35 55386c6a-9e32-41d4-af7a-e79596221f51 -> ../../xvda9
lrwxrwxrwx 1 root root 11 Jul 22 01:35 55f36660-9bac-478c-a701-7ecc5347f789 -> ../../xvda8
lrwxrwxrwx 1 root root 11 Jul 22 01:35 780f36bc-0ada-4c98-9a8d-44570d65333d -> ../../xvda1
lrwxrwxrwx 1 root root 11 Jul 22 01:35 b3b7c47f-6a91-45ef-80d6-275b1cc16e19 -> ../../xvda6
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lrwxrwxrwx 1 root root 11 Jul 22 01:35 ea63b55d-3b6e-4dcd-8986-956b72bac3e9 -> ../../xvda7
lrwxrwxrwx 1 root root 12 Jul 22 01:35 eb3cc645-925e-4bc5-bedf-c2a6f3b65809 -> ../../xvda10

The content on the left of -> is the disk partition UUID, and that on the right
of -> is the partition name. Obtain the relationship between the disk partition
name, partition ID, and partition UUID.

3. Run the following command to check the partition names in the /etc/fstab
file:

vi /etc/fstab

The example command output is as follows.
/dev/disk/by-id/scsi-SATA_QEMU_HARDDISK_QM00001-part5 / ext3 defaults,errors=panic 1 1
/dev/disk/by-id/scsi-SATA_QEMU_HARDDISK_QM00001-part1 /boot ext3 defaults,errors=panic 1 2
/dev/disk/by-id/scsi-SATA_QEMU_HARDDISK_QM00001-part6 /home ext3 nosuid,errors=panic 1 2
/dev/disk/by-id/scsi-SATA_QEMU_HARDDISK_QM00001-part10 /opt ext3 defaults,errors=panic 1 2
/dev/disk/by-id/scsi-SATA_QEMU_HARDDISK_QM00001-part7 /tmp ext3 nodev,nosuid,errors=panic 1 2
/dev/disk/by-id/scsi-SATA_QEMU_HARDDISK_QM00001-part9 /usr ext3 defaults,errors=panic 1 2
/dev/disk/by-id/scsi-SATA_QEMU_HARDDISK_QM00001-part8 /var ext3 nodev,nosuid,errors=panic 1 2
sysfs /sys sysfs noauto 0 0
proc /proc proc defaults 0 0
usbfs /proc/bus/usb usbfs noauto 0 0
devpts /dev/pts devpts mode=0620,gid=5 0 0
/dev/cdrom /media/ udf,iso9660 noexec,noauto,nouser,nodev,nosuid 1 2
tmpfs /dev/shm tmpfs noexec,nodev,nosuid 0 0

The values in the first column are the disk partition IDs.

4. Press i to enter editing mode. Change the disk partition ID in the row that
contains /dev/disk/xxx in the /etc/fstab file in step 3 to UUID=UUID of the
disk partition based on the query results in step 1 and step 2.

The modified content is as follows.
UUID=45ecd7a0-29da-4402-a017-4564a62308b8 / ext3 defaults,errors=panic 1 1
UUID=780f36bc-0ada-4c98-9a8d-44570d65333d /boot ext3 defaults,errors=panic 1 2
UUID=b3b7c47f-6a91-45ef-80d6-275b1cc16e19 /home ext3 nosuid,errors=panic 1 2
UUID=eb3cc645-925e-4bc5-bedf-c2a6f3b65809 /opt ext3 defaults,errors=panic 1 2
UUID=ea63b55d-3b6e-4dcd-8986-956b72bac3e9 /tmp ext3 nodev,nosuid,errors=panic 1 2
UUID=55386c6a-9e32-41d4-af7a-e79596221f51 /usr ext3 defaults,errors=panic 1 2
UUID=55f36660-9bac-478c-a701-7ecc5347f789 /var ext3 nodev,nosuid,errors=panic 1 2
sysfs /sys sysfs noauto 0 0
proc /proc proc defaults 0 0
usbfs /proc/bus/usb usbfs noauto 0 0
devpts /dev/pts devpts mode=0620,gid=5 0 0
/dev/cdrom /media/ udf,iso9660 noexec,noauto,nouser,nodev,nosuid 1 2
tmpfs /dev/shm tmpfs noexec,nodev,nosuid 0 0

NO TE

Ensure that the UUIDs are correct. Otherwise, the ECS cannot start properly.

5. Press Esc, enter :wq, and press Enter. The system saves the configuration and
exits the vi editor.

6. Check the partition names in the system boot configuration file.

The system boot configuration files vary depending on the OS. Confirm the
boot configuration file of the current OS.

– Grand Unified Boot Loader (GRUB) configuration file

▪ /boot/grub/grub.conf

▪ /boot/grub/menu.lst

▪ /boot/grub/grub.cfg
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▪ /boot/grub2/grub.cfg

– Syslinux configuration file

▪ /extlinux.conf

▪ /boot/syslinux/extlinux.conf

▪ /boot/extlinux/extlinux.conf

▪ /boot/syslinux/syslinux.cfg

▪ /syslinux/syslinux.cfg

▪ /syslinux.cfg

The boot file in this example is /boot/grub/menu.lst. Run the following
command to check it:
vi /boot/grub/menu.lst
default 0
timeout 3
title xxx Server OS - xxxxxx
kernel /boot/vmlinuz-3.0.101-0.47.52-default root=/dev/disk/by-id/scsi-
SATA_QEMU_HARDDISK_QM00001-part5 resume= memmap=0x2000000$0x3E000000 
nmi_watchdog=2 crashkernel=512M-:256M console=ttyS0,115200 console=tty0 xen_emul_unplug=all
initrd /boot/initrd-3.0.101-0.47.52-default

7. Press i to enter editing mode and change the partition names in the system
boot configuration file.
Change the disk partition name in the /boot/grub/menu.lst file in 6 to
UUID=UUID of the disk partition based on the query results in 1 and 2.
default 0
timeout 3
title xxx Server OS - xxxxxx
kernel /boot/vmlinuz-3.0.101-0.47.52-default root=UUID=45ecd7a0-29da-4402-a017-4564a62308b8 
resume= memmap=0x2000000$0x3E000000 nmi_watchdog=2 crashkernel=512M-:256M 
console=ttyS0,115200 console=tty0 xen_emul_unplug=all
initrd /boot/initrd-3.0.101-0.47.52-default

8. Press Esc, enter :wq, and press Enter. The system saves the configuration and
exits the vi editor.

13.5 What Do I Do If the Disks of an ECS Created from
a CentOS Image Cannot Be Found?

Symptom
Generally, this is because the xen-blkfront.ko module is not loaded during the
startup. You need to modify OS kernel startup parameters. Figure 13-1 shows the
startup screen after the login to the ECS.
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Figure 13-1 Startup screen

Solution
Perform the following operations to modify OS kernel boot parameters:

NO TE

These operations must be performed after the OS starts. You are advised to modify kernel
boot parameters in the ECS used for creating the image.

1. Run the following command to log in to the OS:
lsinitrd /boot/initramfs-`uname -r`.img |grep -i xen
– If the command output contains xen-blkfront.ko, contact the customer

service.
– If no command output is displayed, go to 2.

2. Back up the GRUB configuration file.
– If the ECS runs CentOS 6, run the following command:

cp /boot/grub/grub.conf /boot/grub/grub.conf.bak
– If the ECS runs CentOS 7, run the following command:

cp /boot/grub2/grub.cfg /boot/grub2/grub.cfg.bak
3. Use the vi editor to open the GRUB configuration file. Run the following

command (using CentOS 7 as an example):
vi /boot/grub2/grub.cfg

4. Add xen_emul_unplug=all to the default boot kernel.

NO TE

Search for the line that contains root=UUID= and add xen_emul_unplug=all to the
end of the line.

menuentry 'CentOS Linux (3.10.0-229.el7.x86_64) 7 (Core) with debugging' --class centos --class gnu-
linux --class gnu --class os --unrestricted $menuentry_id_option 'gnulinux-3.10.0-229.el7.x86_64-
advanced-bf3cc825-7638-48d8-8222-cd2f412dd0de' {
        load_video
        set gfxpayload=keep
        insmod gzio
        insmod part_msdos
        insmod ext2
        set root='hd0,msdos1'
        if [ x$feature_platform_search_hint = xy ]; then
          search --no-floppy --fs-uuid --set=root --hint='hd0,msdos1'  bf3cc825-7638-48d8-8222-
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cd2f412dd0de
        else
          search --no-floppy --fs-uuid --set=root bf3cc825-7638-48d8-8222-cd2f412dd0de
        fi
        linux16 /boot/vmlinuz-3.10.0-229.el7.x86_64 root=UUID=bf3cc825-7638-48d8-8222-
cd2f412dd0de xen_emul_unplug=all ro crashkernel=auto rhgb quiet  systemd.log_level=debug 
systemd.log_target=kmsg
        initrd16 /boot/initramfs-3.10.0-229.el7.x86_64.img
}

5. Press Esc, enter :wq, and press Enter to exit the vi editor.
6. Create an image using the ECS, upload and register the image on the cloud

platform.

13.6 What Do I Do If an ECS Created from a Windows
Image Failed to Start When I Have Enabled Automatic
Configuration During Image Registration?

Symptom

This issue is probably caused by the failure of offline VirtIO driver injection.

Solution

When you inject the VirtIO driver for a Windows ECS offline, there are some
restrictions:

● If the boot mode in the image file is UEFI, the VirtIO driver cannot be injected
offline.

● It is recommended that you disable Group Policy Object (GPO). Some policies
may cause the failure of VirtIO driver injection offline.

● It is recommended that you stop antivirus software. Otherwise, the VirtIO
driver may fail to be injected offline.

To update the VirtIO driver, you must install UVP VMTools. For how to install UVP
VMTools, see Optimizing a Windows Private Image.

13.7 What Do I Do If an Exception Occurs When I Start
an ECS Created from an Image Using the UEFI Boot
Mode?

Symptom

An ECS created from a private image using the UEFI boot mode cannot start.

Possible Causes

The image OS uses the UEFI boot mode, but the uefi attribute is not added to the
image.
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Solution
1. Delete the ECS that failed to start.
2. Call the API to update the image attributes and change the value of

hw_firmware_type to uefi.
API URI: PATCH /v2/cloudimages/{image_id}
For details about how to call the API, see Updating Image Information.

3. Use the updated image to create an ECS.
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14 Billing

14.1 What Are the Billing Standards of IMS?

Billing of Different Image Types
Image Type Billing

Private ● System disk image, ISO image, or data disk image: free
OBS buckets invisible to users are provided for free to
store the images.

● Full-ECS image: charged for the storage on CSBS or CBR
If the image is created from a CSBS or CBR backup, you
will be billed for the space used to store the CSBS or CBR
backup.

Shared ● If it is a system or data disk image, the OBS storage is
free.

● If it is a full-ECS image, you will be billed for the space
used to store the CBR backup.
NOTE

Full-ECS images created from a CBR backup can be shared but
those created from a CSBS backup cannot.

 

Billing of Private Image Operations
Operation Billing Item

Uploading an external
image file to an OBS
bucket

OBS storage (You are advised to delete unneeded
image files.)
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Operation Billing Item

Creating an ECS from a
system disk image or full-
ECS image

EVS disks attached to the created ECS (The system
disk image and full-ECS image are free of charge.)
For example, when you use a full-ECS image (with
a 40 GB system disk and 100 GB data disk) to
create an ECS, you will be charged based on the
total size of the system disk and data disk.

Replication of a system or
data disk image within a
region

None. OBS buckets are available for free to store
the image copies.

Exporting images OBS space for storing the exported images

 

Reference
● For OBS pricing details, see OBS Pricing Details.
● For CSBS pricing details, see CSBS Pricing Details.
● For CBR pricing details, see CBR Pricing Details.
● For EVS pricing details, see EVS Pricing Details.
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15 Change History

Released On Description

2023-08-10 This issue is the second official release.
Modified the following content:
Deleted cloudResetPwdUpdateAgent in What Do I Do If the
One-Click Password Resetting Plug-In Failed to Start?.

2022-08-30 This issue is the first official release.
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